
UE-1031

MAINT

FAIL

ACTIVE

SHELF FAL

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAINT

FAIL

ACTIVE

MAI

FAIL

ACTI

297-8391-501

Front coverDMS-100

Universal Edge 9000
Data Testing and Troubleshooting Guide

NA015  Standard 01.01  March 2001





Title page

UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

DMS-100

Universal Edge 9000 DMS
Data Testing and Troubleshooting Guide

Document number: 297-8391-501
Document release: Standard 01.01
Date: March 2001

Copyright  2001 Nortel Networks. All Rights Reserved.

Printed in the United States of America

PROPRIETARY: The information contained in this document is the property of Nortel Networks. Except as
specifically authorized in writing by Nortel Networks, the holder of this document (1) shall keep all information
contained herein confidential and shall protect same in whole or in part from disclosure and dissemination to all
third parties, and (2) shall use same for operation and maintenance purposes only.

All information contained in this document is subject to change without notice. Nortel Networks reserves the right
to make changes to equipment design or program components, as progress in engineering, manufacturing
methods, or other circumstances may warrant.

ACCESSNODE, ACCESSNODE EXPRESS, UE9000, UNIVERSAL EDGE, NORTEL, and NORTEL
NETWORKS are trademarks of Nortel Networks Corporation.
UNIX is a registered trademark licensed exclusively through X/Open Company Limited.
HP Open View, Hewlett Packard, and Network Node Manager are trademarks of Hewlett Packard Corporation.
Ethernet is a trademark of Xerox Corporation.
Solaris, Sun, and Ultra are trademarks of Sun Microsystems, Incorporated.





iii

UE9000 D

Publication history

March 2001
NA015 Standard 01.01 release of this document.  Includes the following
changes:

• removed SDSL and 1MM line cards from document, since they are not
applicable to the UE 9000 DMS

• added DS3 ATM card information throughout document

August 2000
AN18 with AD3.0 Beta 1.1 release of the document. Includes the following
changes:

• Added SDSL alarm descriptions and procedures.
MS   Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

• Made information and procedures in Chapters 1 and 2 generic by
changing “ADSL” to “xDSL.”

• Added CPE troubleshooting information to Chapter 1.

• Added a procedure for troubleshooting slow data rate speeds to
Chapter 1.

• Added information on DS3 ATM core cards throughout document, where
appropriate

• Added information on 1-Meg Modem multi-circuit line cards throughout
document, where appropriate

• Added information on SDSL multi-circuit line cards throughout
document, where appropriate

• Added Procedure 2-8, “Upgrading the firmware”.



iv   Publication history

ocument, Issue 1. This book was created from
dge 9000 Data OAM&P User Guide.
moved from the previous version of the
&P User Guide, reorganized and updated for
t.
July 2000
AN18 Standard release of this d
a restructuring of theUniversal E
Chapters 3, 5, 6, and 7 were re
Universal Edge 9000 Data OAM
AN18, Issue 1 of this documen
UE9000 DMS 297-8391-501 NA015



v

UE9000 D

Table of Contents

About this document ix
Audience ix
Required reading ix
How to use this guide ix
Additional documentation x
Radio-frequency emissions notice x
About the UE9000 xi

Troubleshooting 1-1
Chapter contents 1-1
Troubleshooting slow data transfer speeds 1-3
uEMS troubleshooting 1-9
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

ATM troubleshooting 1-16
Line card troubleshooting 1-19
Procedure 1-1 Troubleshooting connection and data service

problems with subscriber service 1-21
Procedure 1-2 Troubleshooting slow data rate speeds 1-30
Procedure 1-3 uEMS cannot communicate with the ATM

core card via SNMP 1-32
Procedure 1-4 ATM core card reboots with previous

software load 1-33
Procedure 1-5 No hardware flag for ATM core card 1-36
Procedure 1-6 xDSL fails loopback test 1-39
Procedure 1-7 Verify uEMS workstation has IP connectivity

to the ATM core card 1-43
Procedure 1-8 ATM core card is not sending traps to the

uEMS workstation 1-46
Procedure 1-9 No hardware flag for an xDSL line card 1-48
Procedure 1-10 Troubleshooting an ATM core card 1-50
Procedure 1-11 Synchronizing the alarm database 1-52



vi   Table of Contents

2-1

 UE9000 components 2-3
e operational state of an ATM
-4
e operational state of a DS1

e operational state of xDSL
line cards 2-8
e operational state of xDSL
ircuits 2-11
n ATM core card 2-14
covery Data 2-17
manual swact on the DS3 ATM

2-19
n xDSL multi-circuit line

e firmware 2-23
n ATM core card 2-29
n xDSL multi-circuit line

monitoring 3-1

3-2

he ATM loopback upstream

he ATM loopback downstream

he inject bad HEC upstream
Hardware management
Chapter contents 2-1
Procedure 2-1 Inventorying
Procedure 2-2 Changing th

core card 2
Procedure 2-3 Changing th

carrier 2-6
Procedure 2-4 Changing th

multi-circuit 
Procedure 2-5 Changing th

subscriber c
Procedure 2-6 Restarting a
Procedure 2-7 Updating Re
Procedure 2-8 Performing a

core cards
Procedure 2-9 Restarting a

card 2-20
Procedure 2-10 Upgrading th
Procedure 2-11 Replacing a
Procedure 2-12 Replacing a

card 2-32

Testing and performance 
Chapter contents 3-1
Performance monitoring 3-2

Creating customized graphs
Performing tests in uEMS 3-12
Procedure 3-1 Performing t

test 3-13
Procedure 3-2 Performing t

test 3-15
Procedure 3-3 Performing t
UE9000 DMS 297-8391-501 NA015

test 3-17
Procedure 3-4 Performing the inject bad payload upstream

test 3-19
Procedure 3-5 Performing the DMT utopia loopback

upstream test 3-21
Procedure 3-6 Performing the one-shot loopback test 3-23

uEMS faults and events 4-1



Table of Contents  vii

Chapter contents 4-1
Faults and events in uEMS 4-2
Procedure 4-1 Viewing events 4-3
Procedure 4-2 Viewing help for a uEMS event 4-5
Procedure 4-3 Deleting events 4-6
uEMS events 4-7
Threshold events 4-23
Line card and circuit faults 4-28
ATU-C   4-30

ATU-C failure   4-30
ATU-C   4-32

ATU-R not present   4-32
ATU-C   4-33

Downstream cells dropped   4-33
ATU-C   4-35

Loss of cell delineation — interleave channel   4-35
ATU-C   4-37

Loss of frame   4-37
ATU-C   4-39

Loss of link   4-39
ATU-C   4-41

Loss of power   4-41
ATU-C   4-43
     UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Loss of signal   4-43
ATU-C   4-45

Modem ATU-C clock failure   4-45
ATU-C   4-46

Non-zero VPI bits   4-46
Modem   4-48

Modem training failure   4-48
ATU-R   4-50

Incompatible Tx mode   4-50
ATU-R   4-52

Loss of cell delineation — interleave channel   4-52
ATU-R   4-54

Loss of frame   4-54
ATU-R   4-56

Loss of link   4-56
ATU-R   4-58

Loss of power   4-58
ATU-R   4-59



viii   Table of Contents

F   4-65
4-67

9

flow   4-80

   4-81
Loss of signal   4-59
ATM50   4-61

DS FIFO overrun   4-61
ATM50   4-62

DS HEC failure   4-62
ATM50   4-63

Line signal fault   4-63
ATM   4-65

Lost communication to ATMI
ATM, line card, circuit, carrier   

Config. failure   4-67
ATM, line card   4-68

Firmware mismatch   4-68
ATM, line card   4-69

Hardware mismatch   4-69
Line card   4-70

In service LC removed   4-70
STU-C   4-71

STU-C failure   4-71
STU-C   4-72

Loss of frame   4-72
STU-C   4-74

Loss of link   4-74
STU-C   4-76

Loss of signal   4-76
STU-R   4-78

Loss of power   4-78
STU-R   4-79

Remote alarm indicator   4-7
Hardware Failure   4-80

Downstream cell buffer over
Hardware Failure   4-81

Upstream cell buffer overflow
UE9000 DMS 297-8391-501 NA015

Hardware Failure   4-82
ATM device timeout   4-82

Hardware Failure   4-83
ATM device parity error   4-83

List of terms 5-1

Index 6-1



ix

UE9000 D

About this document

Audience
The intended audience for this document includes the following groups:

• maintenance technicians and experienced installers

• network administrators

Required reading
Before using this book, you should be familiar with the Release Notes for the
Universal Edge 9000 element management system (uEMS). The Release
Notes are provided on the uEMS software CD-ROM.

If you have limited experience with Hewlett Packard’s™ HP OpenView™

How to use t
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Network Node Manager™ graphical user interface software, you should read
Appendices A and B of theUE9000 Data OAM&P User Guidebefore using
this guide.

his guide
This guide is designed to be used after the following events have occurred:

• uEMS software is operational; that is, it has been installed and connected
to the network

• The Universal Edge 9000 shelf has been installed; cables and power are
connected

Note: For more information on performing these prerequisites, see the
UE9000 Installation Quick Reference Guide and theUE9000 Data
System Setup Guide.

This guide should be used with the Hewlett Packard HP OpenView Network
Node Manager documentation.
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Additional documentation
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with the instruction manual, ma
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communications. Operation of this equipment in a residential area may cause
harmful interference, in which case the user will be required to correct the
interference at his own expense.”
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About the UE9000
The Universal Edge 9000 (UE9000) is a shelf on the AccessNode that
provides voice and data services. The UE9000 supports the following circuit
cards:

• DS1 IMA ATM (asynchronous transfer mode) core card

• DS3 ATM core card

• TDM card (time division multiplexing)

• SI card (system interface)

• Power I/O card

• Multi-circuit line card

AccessNode can support up to seven UE9000 shelves. Each UE9000 has a
greater line density than traditional copper distribution shelves.

You provision and monitor data services independently from voice services
using the UE9000 element management system (uEMS). The uEMS runs on
an HP OpenView workstation and uses a graphical user interface. For
information about the data network configuration, see theUE9000 Data
Network Design Guidelines.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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Troubleshooting 1-

This chapter describes how to troubleshoot the Universal Edge 9000
(UE9000) data components.

Chapter contents
This chapter includes the following topics:

• Troubleshooting slow data transfer speeds

• uEMS troubleshooting

• ATM troubleshooting

• Line card troubleshooting

This chapter includes the following tasks:
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Task See

Troubleshooting connection and data
service problems with subscriber service

Procedure 1-1 on page 1-21

Troubleshooting slow data rate speeds Procedure 1-2 on page 1-30

uEMS cannot communicate with the ATM
core card via SNMP

Procedure 1-3 on page 1-32

ATM core card reboots with previous
software load

Procedure 1-4 on page 1-33

No hardware flag for ATM core card Procedure 1-5 on page 1-36

xDSL fails loopback test Procedure 1-6 on page 1-39

—continued—
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Procedure 1-7 on page 1-43

to the Procedure 1-8 on page 1-46

 card Procedure 1-9 on page 1-48

Procedure 1-10 on page 1-50

Procedure 1-11 on page 1-52

—end—

See
Verify uEMS workstation has IP
connectivity to the ATM core card

ATM core card is not sending traps
uEMS workstation

No hardware flag for an xDSL line

Troubleshooting an ATM core card

Synchronizing the alarm database

Task
UE9000 DMS 297-8391-501 NA015
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Troubleshooting slow data transfer speeds
Troubleshooting slow data transfer rate problems can be difficult in a complex
network, where many aspects of the end-to-end data path are not under the
direct control of the person doing the troubleshooting. Unfortunately, this is
the situation in a typical access service provider network.

Figure 1-1 shows the various portions of an end-to-end user data path, from
the customer premises to a server on the internet.

Figure 1-1
Typical end-to-end user data path

UE-1042

PCs

CPE

User ISP InternetxDSL loop Access Network

UE9000 ATM
Network Internet

Server
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Elements that can influence the data transfer rate occur in all locations within
the network. In general they include processing speeds (PCs, network
switching equipment, routers, servers), buffer sizes, protocol
implementations, line speeds (access links, network trunks), delays
(modulation/error correction, propagation, queuing, processing), error rates
(transmission errors, packet discards due to congestion), and packet size.

TCP/IP protocol
Slow data transfer rates are most obvious during large file transfers, which
generally use TCP/IP as the end-to-end protocol.

There are many implementations of the basic TCP/IP protocol, with different
performance characteristics. In addition, there have been recent extensions to
TCP/IP. These include: RFC1323, TCP Large Window, and RFC2018, TCP
Selective Acknowledgment. All of these implementations include variable
parameters that impact overall throughput. Changing parameters involves
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meters to optimize throughput is not straight
ided that give acceptable performance in

/IP throughput are line speed and round trip

ess line has the lowest data rate in the
he most affect. For ADSL lines, the upstream
down stream data rate. For file transfers from

ssue, since the upstream (acknowledgment)
the downstream packets, so the packet

ed by several factors, including
ys on the access line (may be adjustable, with
across the network (typically small),
pendent upon packet size and line data rate),
itches/routers (variable, depending upon

rocessing delay, primarily at the server
c levels).

affecting data throughput are packet loss and
nd tuning.

 errors that exceed the error correction
, packet errors in the ATM network, or
rk congestion on network links or within
trade-offs, so tuning these para
forward. Default values are prov
typical situations.

The major factors affecting TCP
delay.

Line speed
In most situations, the user acc
end-to-end data path and has t
data rate is much lower than the
a remote server, this is not an i
packets are much smaller than 
transmission time is small.

Round trip delay
The round trip delay is influenc
modulation/error correction dela
trade-offs), propagation delays 
transmission delays (variable de
packet queuing delays in the sw
traffic congestion levels), and p
(variable, depending upon traffi

The next most important factors
TCP protocol implementation a

Packet loss
Packet loss can result from line
capability of the xDSL modems
discarded packets due to netwo
switches and/or routers.

TCP/IP implementation
UE9000 DMS 297-8391-501 NA015

Early implementations of TCP/IP are very sensitive to delay and packet loss.
Recent extensions (RFC 1323: TCP Large Window and RFC 2018: TCP
Selective Acknowledgments) significantly improve throughput in larger delay
situations and where packets are occasionally lost due to errors or congestion.
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Approaches to troubleshooting slow data transfer speeds
If a customer experiences slow data transfer speeds at all times, and from all
sources, the problem is most likely with the customer loop (low line speed,
delay) or the customer equipment (PC, PC software or setup).

If several customers on the same UE9000 shelf have the same complaint,
always poor performance, then the problem is most likely with the UE9000
equipment or the links to the network.

If the customer experiences slow data transfer speeds only occasionally, and
at the same time as other users on the same UE9000 shelf, then the problem
is more likely to be network congestion somewhere between the UE9000
shelf and the server, or due to excess load on the server itself.

A careful review of the circumstances helps to find the most probable cause.

Customer premise equipment
It is important to understand that it is not possible for a customer to achieve a
file transfer rate that matches the xDSL line rate.

First, the user data rate is approximately 15% less than the xDSL line rate due
to protocol overheads (ATM cells, IP, TCP, PPPoE, etc.) and the average
packet size. This means an 8 Mb/s xDSL line rate can carry at best
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

approximately 6.8 Mb/s of user data.

Second, the TCP/IP protocol implementation can have a major impact on file
transfer rate.

File transfer rate is very dependent upon round trip delay, window sizes,
packet errors and buffer sizes. Extensions to TCP (RFC 1323: TCPLW and
RFC 2018: SACK) can significantly improve file transfer rates.

For example, Windows 95 has a basic TCP implementation, whereas
Windows 98 and higher support the extensions.

With a 6.6 Mb/s line rate, and a round trip delay of 18 msecs, Windows 95 can
achieve a file transfer rate of approximately 2.5 Mb/s. Increasing the round
trip delay to 34 msecs reduces the file transfer rate to less than half this
amount.

Windows 2000 achieves approximately 5.2 Mb/s with a round trip delay of 18
msecs, which is close to the theoretical maximum for that line rate.
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condition, and the line quality later improves, the line does not automatically
return to a higher line rate. It must be forced to resynch, either by the customer
or the network operator.

For G.Lite circuits, similar events will cause the modems to perform a full
resynchronization, and, similarly, the subscriber's data session will be
interrupted. In addition, there may be a number of “fast” resynchronizations
that take place due to other, less severe changes in loop conditions. These “fast
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retrains” may cause delays in the user's data session, but should not cause the
user data session to drop. See theUE9000 Data Network Design Guidelines,
Appendix B: “Full-rate ADSL and G.Lite,” for more details on fast retrains.

ADSL local loop — ADSL delay
ADSL implementations provide a feature called interleaving to improve the
data error rate in the presence of impulse noise on the local loop. Although the
error rate may be improved, it is done at the expense of increased delay.

The UE9000 equipment has default interleaving delays of 10 msec upstream
and downstream, for a total of 20 msecs.

In situations where impulse noise is not a problem, there may be an
improvement in file transfer rate by reducing these delays to zero, especially
if the remaining round trip delay is small.

Network transmission facilities, switches, and routers
Network facilities can contribute to poor data transfer rates primarily due
packet loss.

Queuing delays vary with traffic levels, but with high speed facilities, queuing
delays are typically small and have minimal impact on performance.

Packet loss has a serious impact on performance, and can be caused by either
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

non-correctable data errors on the transmission facilities, or packet discards
due to congestion.

Data errors on transmission facilities cause errored IP packets, resulting in
retransmissions, and reduced data throughput. If the error rate is high enough
to significantly reduce data throughput, the impact is not limited to a
particular user, but impact all active users on that facility.

When using the unspecified bit rate (UBR) traffic class for user data service,
packet loss due to congestion affects all active users.

If packet loss is suspected, the ATM switches and routers can be monitored
for ATM cell errors and cell or packet discards due to congestion. Refer to the
user manuals for the particular equipment to determine how to monitor for
these conditions. If the equipment or facilities are supported by a third party
service provider, request this information from them.
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uEMS troubleshooting
SeeTable 1-1 for troubleshooting information on the UE9000 element
management system (uEMS) graphical user interface (GUI).

Table 1-1
uEMS troubleshooting

Symptom Cause Solution

Communications problems

uEMS cannot communicate
with the ATM card

loss of communications See Procedure 1-3 on page 1-32
and Procedure 1-7 on page 1-43.

No communication between
all ATM cards and the uEMS

Loss of network connectivity Evaluate the connectivity and status
of the transport network.

No hardware flag for an ATM
core card that has hardware

communication may be
down between the ATM card
and uEMS workstation

Verify IP connectivity and SNMP
communication from uEMS to the
ATM card. See Procedure 1-3 on
page 1-32 and Procedure 1-7 on
page 1-43.

HPOV did not discover the
ATM card. There is no
symbol for the ATM card on

See Procedure 1-5 on page 1-36.

If the problem does not clear, see
the Hewlett Packard document
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

the IP Internet submap. Using Network Node Manager,
J1136-90002, for information on
discovering IP objects.

uEMS did not receive an
event indicating that a restart
completed on the DAC

ATM core card provisioned
but the ATM hardware is not
installed

See Procedure 1-5 on page 1-36.

Incorrect provisioning Verify the ATM card has the correct
IP address for the uEMS
workstation. Verify that uEMS has
the correct IP address for the ATM
card.

—continued—



1-10   Troubleshooting

Wait until ATM finishes rebooting.

d,
ot

Install ATM hardware.

n’s
• Verify that the ATM core card has

the uEMS workstation’s IP
address using the local craft
interface (LCI)

• If the ATM core card has an
incorrect IP address or no IP
address, provision the uEMS IP
address on the ATM core card
using the LCI

• Verify that uEMS is provisioned
with the proper ATM core card
address

or
• Switch (swact) the TDMs

• Restart the ATM card

• Replace the ATM card using
Procedure 2-11 on page 2-29.

Solution
No communication between
one ATM and the uEMS

ATM rebooting

ATM has been provisione
but ATM hardware has n
been installed

ATM was not provisioned
with the uEMS workstatio
IP address

No communication between
the ATM card and the TDM
cards

xDSL line card LEDs do not
function properly

uEMS cannot detect card
insertion on UE9000 shelf

Software or hardware
problem on the ATM card
TDM cards

—continued—

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause
UE9000 DMS 297-8391-501 NA015
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uEMS operation problems

You cannot provision:

• a UE9000 shelf

• an ATM core card

UE9000 component was
unprovisioned, but the
hardware was not removed
from the system

remove the unprovisioned ATM or
xDSL line card hardware

the symbol for the UE9000
component was hidden or
deleted, but the UE9000
component was not
unprovisioned from the
uEMS database

unprovision the UE9000 component
using the command line interface
(CI), then reprovision the UE9000
component

uEMS does not detect
inventory and status
changes

uEMS or HP OpenView
(HPOV) background
processes are not
functioning correctly

the ATM core card is not
communicating with the time
division multiplexing (TDM)

• Check the uEMS and HPOV
background processes by typing
at the prompt in a terminal
window:
/opt/OV/bin/ovstatus ↵

• Each background process should
have a state of RUNNING.

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

circuit cards • If the background processes are
not running, manually start them.
To start the HPOV background
process type:
/opt/OV/bin/ovstart ↵
To start the uEMS background
process type: /opt/OV/bin/ovstart
hstpmon ↵

—continued—
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using the ATM pop-up menu, put the
ATM in the in-service (unlock) state

ed

remove the unprovisioned ATM core
card or xDSL line card hardware

0
r

unprovision the UE9000 component
using the command line interface
(CI), then reprovision the UE9000
component

to DS1 link numbers 1 and 2 in the IMA
group cannot be unprovisioned.

lock the line card

provision the cross connects down

See the UE9000 Data OAM&P User
Guide for unprovisioning
information.

• Check the bottom left corner of the
submap for read-write status

• Check if another user has the map
open. If another user has the map
open, then all other users have
read-only access to the map.

• See the UE9000 Data OAM&P
User Guide for information on

Solution
You cannot provision an
xDSL line card

the ATM card is locked

UE9000 component was
unprovisioned, but the
hardware was not remov
from the system

the symbol for the UE900
component was hidden o
deleted, but the UE9000
component was not
unprovisioned from the
uEMS database

You cannot unprovision a
DS1 carrier

someone has attempted 
delete all the DS1s

You cannot unprovision an
xDSL line card

line card is not locked

cross connects are up

You cannot edit the UE9000
components in a submap

submap is read-only

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause
UE9000 DMS 297-8391-501 NA015

opening a temporary read-write
map.

—continued—
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You cannot drag a symbol
into a submap

used the left or right mouse
button

• Use the middle mouse button to
drag the symbol.

• Check to determine if the submap
will accept the particular UE9000
component. Check the messages
displayed in the Add Object-Set
Attributes dialog.

You cannot add a UE9000
component to a submap

submap is read-only • Check the bottom left corner of the
submap for read-write status.

• Check if another user has the map
open. If another user has the map
opened, then all other users have
read-only access to the map.

• See the UE9000 Data OAM&P
User Guide for information on
opening a temporary read-write
map.

adding a UE9000 Check to determine if the submap

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

component that cannot be
added to the submap

can take the particular UE9000
component. Check the messages
displayed in the Add Object-Set
Attributes dialog.

uEMS database disk is full • In a UNIX terminal window, at the
prompt, type:

bdf ↵
• In a Solaris terminal window, at

the prompt, type:

df -bk ↵
• If the disk is full, free up disk

space.

—continued—
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of

ing

See Procedure 1-11 on page 1-52.

off • no action is necessary. When the
modem is turned on, the CPE
symbol turns green.

• check LED on CPE modem

per
ate

• replace with the a modem of the
correct xDSL type

• replace the PC

Wait until uEMS polling is
completed. After the loop has been
polled, the loop displays as
in-service.

• In a UNIX terminal window, at the
prompt, type:

bdf ↵
• In a Solaris terminal window, at

the prompt, type:

df -bk ↵
• If the disk is full, free up disk

space.

Solution
Trouble status problems

The alarm counts on uEMS
symbols do not match the
alarm counts in the Alarm
Browser.

• alarm database is out 
sync with the uEMS
database

• alarm database is miss

Subscriber’s CPE symbol is
red

• PC or modem is turned

• modem is faulty

• modem is not of the pro
type of xDSL to termin
the loop

• PC is faulty

uEMS indicates a subscriber
loop is down when the loop is
up and synchronized

slow uEMS polling of
UE9000 components

disk is full and uEMS
database entries are not
being updated

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause
UE9000 DMS 297-8391-501 NA015

uEMS indicates there is
excessive data loss on the
CPE

• excessive noise on loop

• incorrect loop length

• faulty hardware

See Procedure 1-1 on page 1-21.

—continued—
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Operational activity problems

ATM reboots with previous
software load

• invalid software load name
on the trivial file transfer
protocol (TFTP) server

• ATM software load was
transferred in ASCII mode

• ATM software load is
corrupted

See Procedure 1-4 on page 1-33.

ATM does not send SNMP
traps to the uEMS
workstation

• loss of communication

• ATM has wrong uEMS
workstation IP address

• ATM booting off a different
network server than the
one the uEMS workstation
is on

• See Procedure 1-8 on page 1-46.

—end—

Table 1-1
uEMS troubleshooting (continued)

Symptom Cause Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 information on the ATM core card.

Solution

and

five
er

• See Procedure 1-7 on page 1-43.

• Wait more than five seconds to
reapply power.

me
r

n

• See Procedure 1-4 on page 1-33.

For a UE9000 shelf equipped with
either a DS1 IMA ATM core card or
a single DS3 ATM core card:

Wait twelve minutes for the ATM
card to restart or reboot. If the ATM
card does not restart or reboot,
reload the ATM software. If the
problem continues, see
Procedure 1-4 on page 1-33.

For a UE9000 shelf equipped with
two DS3 ATM core cards:

An auto-swact will occur if the
“active” DS3 ATM card is
ATM troubleshooting
SeeTable 1-2 for troubleshooting

Table 1-2
ATM core card troubleshooting

Symptom Cause

uEMS cannot ping the ATM • No communication
between the ATM card
the uEMS workstation

• Did not wait more than
seconds to reapply pow

ATM card does not reboot • invalid software load na
on the trivial file transfe
protocol (TFTP) server

• ATM software load is
corrupted

• the TFTP server is dow

ATM card takes too long to
restart or reboot

ATM card has been
upgraded with a new
software load
UE9000 DMS 297-8391-501 NA015

restarted/reloaded. Within 3
minutes, the “standby” DS3 ATM
card will become “active”

Note: No switch (swact) will occur if
the “standby” DS3 ATM card is
restarted/reloaded.

—continued—
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Cannot perform a switch
(swact) between the “active”
and “standby” DS3 ATM
core cards

• “standby” DS3 ATM card is
not ready

• second DS3 ATM card is
not present in the UE9000
shelf

• the “standby” card is
reloading

• the “active” card is locked

• both cards are receiving
LOS

• Make sure the “standby” card is
active-ready

• Install and provision the second
DS3 ATM core card

• Wait until “standby” card has
finished reloading

• Unlock the ATM card. See
Procedure 2-2 on page 2-4

• Check cabling

 NVStore download fails • Database is corrupt

• NVStore file is too large

• Call Nortel Networks technical
support

• Check the path /etc/opt/OV/share/
conf/Nortel/HSTP/uems/nvstore
and make sure the file size is less
than 750 KB. If the file size is
larger than 750 KB, contact Nortel
Networks technical support

Table 1-2
ATM core card troubleshooting (continued)

Symptom Cause Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

• Network problem • Check network connection

xDSL line card is not passing
data service

• xDSL line card is faulty

• ATM is faulty

• CPE is faulty

• no cross-connect is
assigned or cross-connect
state is not in-service
(down)

• See Procedure 1-1 on page 1-21.

—continued—
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on

nd

• Disable scrambling on the far-end
equipment, if the UE9000 has a
DS1 IMA core card in the shelf.
(The DS1 IMA. does not support
scrambling. The UE9000 DS3
ATM core card, however, does
support scrambling.)

f of
r

S

• See Procedure 1-8 on page 1-46.

• See Procedure 1-10 on
page 1-50.

• See Procedure 1-10 on
page 1-50.

 page 1-50.

 page 2-29.

Solution
All received ATM cells are
corrupted, generating CRC
errors.

• Scrambling is enabled 
the far-end equipment

• physical layer
convergence protocol
(PLCP) problem

• timing problem

• cabling problem, e.g., a
mismatch of Ethernet a
ATM cables

ATM card does not send
traps to uEMS workstation

• ATM card is booting of
another network serve

• ATM card is faulty

• IP address of the uEM
workstation is not
provisioned on the ATM
core card

ATM card fails an in-service
test

faulty ATM card

ATM card fails an
out-of-service test

faulty ATM card

ATM card is not functioning
correctly

• See Procedure 1-10 on

ATM card needs to be
replaced

• See Procedure 2-11 on

—end—

Table 1-2
ATM core card troubleshooting (continued)

Symptom Cause
UE9000 DMS 297-8391-501 NA015
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Line card troubleshooting
SeeTable 1-3 for troubleshooting information on the xDSL line card.

Table 1-3
Line card troubleshooting

Symptom Cause Solution

xDSL circuit takes a long
time to synchronize after
power up

• loop is faulty

• xDSL circuit is
synchronizing to a lower
than provisioned data rate
speed

• Verify that voice service is
provisioned and working on the
subscriber loop

• Troubleshoot the loop

• Test the xDSL line card

• Replace the xDSL line card

• See Procedure 1-1 on page 1-21.

uEMS GUI cannot detect the
xDSL line card

• voice-only line card in slot

• faulty xDSL line card

• faulty TDM

• uEMS processes not
running

• See Procedure 1-9 on page 1-48.

No hardware flag for xDSL
line card

xDSL line card is not passing • xDSL circuit out of • See Procedure 1-1 on page 1-21.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

data service synchronization

• xDSL line card is locked

• CPE is OOS

• xDSL circuit is locked

• cross-connect is not
in-service (down)

xDSL line card fails a
loopback test

• xDSL line card is faulty

• ATM is faulty

• UE9000 backplane is
faulty

• See Procedure 1-6 on page 1-39.

—continued—
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 is
• Wait 5 minutes per subscriber

circuit for the reload to complete.
See Procedure 2-9 on page 2-20.

• Ensure that the network is reliable.

s

rd,

op

• wait a few minutes for the noise to
clear

• see Procedure 1-1 on page 1-19.

• see Procedure 1-1 on page 1-19.

Solution
ADSL line card takes a long
time to complete a restart
reload

or

xDSL line card takes a long
time to complete a restart
reload

• line card load has a
different DSP load than
currently used

• management network
congestion

xDSL circuit does not sync to
maximum speed or
experiences intermittent
data transfer

• the line has temporary
noise

• the subscriber loop
features poor
characteristics, such a
permanent line noise

• xDSL line card, ATM ca
or CPE may be faulty

• excessive subscriber lo
length

—end—

Table 1-3
Line card troubleshooting (continued)

Symptom Cause
UE9000 DMS 297-8391-501 NA015
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Procedure 1-1
Troubleshooting connection and data service problems
with subscriber service

Use this procedure to:

• evaluate problems with UE9000 customer premise equipment (CPE)

• evaluate a subscriber’s connection problems with their internet service
provider (ISP)

• troubleshoot when an xDSL line card cannot pass data from the ATM
core card to the CPE or vice versa

General problems with the CPE may indicate a specific problem at the
subscriber location, central office (CO), or ISP. For more information, refer to
the respective CPE user manual.

The following steps suggest ways for you to troubleshoot this type of
problem. After completing a step, proceed to the next step only if necessary.

Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Step Action

Check that the UE9000 equipment is in-service.

1 From the Subscriber Loop submap (see the UE9000 Data OAM&P
User Guide), confirm that all the UE9000 equipment is in-service.

—continued—

If the Then

ATM card is not in-service
(locked)

Put the ATM card in-service.

xDSL line card is not
in-service (locked)

Put the xDSL line card in-service.

xDSL circuits are not
in-service (locked)

Put the xDSL circuits in-service.

Cross-connects are not
in-service (down)

Put the cross-connects in-service (up)

CPE is not in-service Go to step 2.
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lems with subscriber service

SL or G.Lite, ensure that the circuit
capabilities of the CPE. See the UE9000
 for more information.

outstanding faults against the line card or
n. See Chapter 4, “uEMS faults and
ion.

 submap and check the status of the data
xDSL circuit is in synch with the CPE. See
 User Guide for more information.

uit should be provisioned with the
ds. See the UE9000 Data OAM&P User
rmation.

 CPE

k that the CPE is turned on, is plugged into
gged into the correct phone jack.

is Then

Go to step 16.

Go to step 5.
Procedure 1-1 (continued)
Troubleshooting connection and data service prob

Step Action

2 If the circuit is full rate xD
provisioning matches the 
Data OAM&P User Guide

3 Verify that no there are no
the circuit under inspectio
events,” for more informat

4 Go to the subscriber loop
throughput. Verify that the
the UE9000 Data OAM&P

Note: The subscriber circ
maximum supported spee
Guide for provisioning info

Check the Loop Status LED on the

5 Ask the subscriber to chec
a power source, and is plu

—continued—

If the minimum data rate 

reached

not reached
UE9000 DMS 297-8391-501 NA015
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Procedure 1-1 (continued)
Troubleshooting connection and data service problems with subscriber service

Step Action

6 Ask the subscriber to check the DSL Network Status LED on the CPE
modem as follows:

On a 1-Meg Modem:

If the LED is Then

green There is a transport problem with the transport
network or PC. Go to step 13.

red or amber Wait a few moments. If the LED turns green, see
above. If the LED stays amber or red, this indicates
a problem with the 8+8 card, the CPE, or the phone
line.

Confirm that the subscriber line has dial tone. This
can be done by having the subscriber plug a phone
into the phone jack on the CPE.

If there is no dial tone on the subscriber line,
establish dial tone on the subscriber line. Go to
step 7.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

On other xDSL Modems:

—continued—

If the LED is Then

green or
yellow

There may be a problem with the subscriber loop
performance, configuration, or with the transport
network. Go to step 13.

red or off There is a problem with either the ATM core card,
the xDSL line card, the CPE, or the subscriber’s
phone line.

Confirm that the subscriber line has dial tone. This
can be done by having the subscriber plug a phone
into the phone jack on the CPE.

If there is no dial tone on the subscriber line,
establish dial tone on the subscriber line. Go to
step 7.
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lems with subscriber service

 the CPE power off and then on.

PE to synchronize with the xDSL circuit.
ck the Loop Status LED on the CPE.

the line card may be causing the problem.
nplug all of the extension phone sets on the
e you are using.

off and then turn it back on.

e set is causing the problem, plug in he
ntil the LED turns red.

et.

p 13.

p 9.

p 13.

p 9.
Procedure 1-1 (continued)
Troubleshooting connection and data service prob

Step Action

7 Ask the subscriber to turn

8 Wait two minutes for the C
Ask the subscriber to che

On a 1-Meg Modem:

On other xDSL Modems:

9 One of the phone sets on
To determine which one, u
line card except for the on

10 Turn the modem’s power 

11 To determine which phon
phone sets, one by one, u

12 Discard the faulty phone s

—continued—

If the LED is Then

green Go to ste

amber or red Go to ste

If the LED is Then

green or
yellow

Go to ste

red or off Go to ste
UE9000 DMS 297-8391-501 NA015
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Procedure 1-1 (continued)
Troubleshooting connection and data service problems with subscriber service

Step Action

Check the Subscriber Loop Performance

13 Check for high error rates on the subscriber line at the uEMS. (See
“Performance monitoring” on page 2.) If high error rates exist,
analyze the characteristics of the line. Troubleshoot any problems if
line characteristics appear adverse to xDSL data transmission. If the
line appears usable upon inspection, go to step 16.

Note: For a temporary solution to adverse line conditions, change
the circuit provisioning parameters to improve immunity to severe line
impairments. See the UE9000 Data OAM&P User Guide for
provisioning information.

Replace the xDSL line card

14 Put the xDSL line card out-of-service (lock) and replace the xDSL line
card. Once the xDSL line card is replaced, put the xDSL line card
in-service (unlock).

15 Wait two minutes for the CPE to synchronize with the xDSL circuit.
Ask the subscriber to check the Loop Status LED on the CPE.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

If the LED is Then

green or
yellow

Go to step 16.

red or off It is likely that the loop or the CPE is faulty. Replace
the CPE and retest. If this fails to clear the problem,
test the subscriber loop. See the UE9000 Voice
OAM&P User Guide for line/loop testing
information.
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lems with subscriber service

D on the CPE

bscriber configuration. Ask the subscriber
 Status LED on the CPE.

mpt to connect to another web site.

fy that the following information is
e PC:

address of personal computer (PC)

 PC gateway(s)

f the transport network.

till available to the subscriber.

p 17.

ubscriber to reconnect the Ethernet cable
E and the PC. Then, have the subscriber

e Ethernet Link Status LED again.

D is green, go to step 17.

D is off, either the subscriber’s Ethernet
ulty, the Ethernet cable is faulty or
cted, or the CPE is faulty. Isolate the

 and replace or repair the faulty
ent.
Procedure 1-1 (continued)
Troubleshooting connection and data service prob

Step Action

Check the Ethernet Link Status LE

16 The problem is with the su
to check the Ethernet Link

Check the transport network

17 Ask the subscriber to atte

18 Ask the subscriber to veri
configured correctly on th

• internet protocol (IP) 

• IP address(es) of the

19 Check the configuration o

20 Ask the ISP if service is s

Check the service configuration

If the LED is Then

green Go to ste

off Ask the s
to the CP
check th

If the LE

If the LE
card is fa
disconne
problem
compon
UE9000 DMS 297-8391-501 NA015

21 Check the CO configuration for the ISP. For example, the transport
network may not be configured correctly.

—continued—
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Procedure 1-1 (continued)
Troubleshooting connection and data service problems with subscriber service

Step Action

22 If you are using a DS1 IMA ATM card, ensure that the far end
equipment does not have scrambling enabled on the IMA interface.
Scrambling is an ATM parameter that UE9000 equipment does not
support over the DS1 IMA links because it is not required at T1
speeds. If scrambling is enabled on the DS1 IMA links, the ATM cells
experience payload corruption, resulting in CRC errors at the CPE.

Note: Scrambling is supported on UE9000 shelves equipped with
the DS3 ATM core card(s).

Check the ATM card

23 Check the DS3 ATM core card network interface LED.

If the LED is Then

green go to step 25.

amber a remote alarm indication (RAI) has been detected.
Check the Alarm Browser (see the UE9000 Data
OAM&P User Guide).

If the ATM edge switch is not receiving a signal
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note 1: In a redundant configuration (UE9000 shelf equipped with
two DS3 ATM core cards), a detected RAI will cause the “active” DS3
ATM core card to automatically switch (swact) once to the “standby”
DS3 ATM card. If this does not clear the RAI condition, no further
swact will take place until the RAI condition is cleared.

Note 2: In a redundant configuration (UE9000 shelf equipped two
DS3 ATM core cards), a detected LOS or LOF on only the “active”
DS3 ATM core card will cause the traffic to automatically switch
(swact) to the “standby” DS3 ATM core card.

—continued—

from the DS3 ATM core card, check the following:
• DS3 transport network to ATM edge switch
• coaxial cable from the Tx output connection of

the “active” DS3 ATM core card
• DS3 I/O cross-connect assembly
• DS3 ATM core card

red A network loss of signal (LOS) or loss of frame
(LOF) condition exists. Go to step 24.
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lems with subscriber service

Then

3
• check the DS3 transport network

feeding the DS3 input of the DS3
I/O cross-connect assembly

• check the DS3 I/O cross-connect
assembly

• check the DS3 ATM core card

3
• check the coaxial cable between the

DS3 ATM card input and the DS3
I/O cross-connect assembly

• check the DS3 ATM core card

• check the DS3 I/O cross-connect
assembly

• check the DS3 transport network
feeding the DS3 input of the DS3
I/O cross-connect assembly

• check the coaxial cable between the
DS3 ATM card input and the DS3
I/O cross-connect assembly

• check the DS3 ATM core card

• check the DS3 I/O cross-connect
assembly

• check the DS3 transport network
feeding the DS3 ATM core card
Rx input

• check the DS3 ATM core card
Procedure 1-1 (continued)
Troubleshooting connection and data service prob

Step Action

24 Check the following:

If there is a network

LOS in a redundant
configuration and both DS
ATM cards are LOS

LOS in a redundant
configuration and one DS
ATM cards is LOS

LOS in a non-redundant
system with a DS3 I/O
cross-connect assembly

LOS in a non-redundant
system without a DS3 I/O
cross-connect assembly
UE9000 DMS 297-8391-501 NA015

—continued—

LOF the DS3 ATM card is receiving a
signal but cannot synchronize its
framing.

• check that the DS3 carrier
provisioning matches the transport
equipment
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Procedure 1-1 (continued)
Troubleshooting connection and data service problems with subscriber service

Step Action

25 Verify that other subscribers on the same line card can receive data.
Verify that other subscribers on other line cards on the same UE9000
shelf can receive data.

If the ATM card is Then

sending data to other
subscribers

Verify that the ATM card provisioning is
correct.

not sending data to other
subscribers

Conduct loopback tests as described in
Chapter 3, “Testing and performance
monitoring,” to isolate where data is
being blocked within the shelf.

CAUTION
Loss of communication
Replacing an ATM core card changes the media
access control (MAC) address of the ATM core
card. Data network devices, such as routers,
must be updated with the MAC address of the
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

26 If the problem still exists, replace the ATM card. See Procedure 2-11
on page 2-29. If the problem does not clear, go to step 27.

27 If you did not replace the CPE in step 16, replace the CPE.

28 If the problem still exists, contact your next level of support.

—end—

new ATM core card. If the data network devices
are not updated, communication with the ATM
core card is lost. Inform your network
administrator of the new MAC address for the
ATM core card.
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ds

slow data rate speeds on a subscriber loop.

part of normal operations. Not all users will
. Some causes of slow data rates are:

e is configured to a lower data rate

s only a low data rate

slow data transfer speeds” on page 1-3for

s may also be caused by half-taps,
, loading coils, and other cable irregularities.

ta rate on the subscriber loop.

.

T symbol for the subscriber loop and select
the pop-up menu.

n dialog appears.

 Map Application  in the Object Attributes

ject dialog appears.

 data rates for the subscriber loop here.

m Speed (kbs): _______________
Procedure 1-2
Troubleshooting slow data rate spee

Use this procedure to evaluate 

A slow data rate speed can be 
achieve the maximum data rate

• the subscriber’s data servic

• the subscriber loop support

Refer to section“Troubleshooting
more information.

Note: Slow data rate speed
bridge-taps, mixed-gauges

Action

Step Action

1 Check the provisioned da

a. Go to the LC submap

b. Right-click on the CC
Provision/Edit  from 

The Object Descriptio

c. Double-click UE9000
field.

The Attributes for Ob

d. Write the provisioned

Maximum Downstrea
UE9000 DMS 297-8391-501 NA015

Maximum Upstream Speed (kbs): _________________

2 Go to the Subscriber Loop submap.

—continued—
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Procedure 1-2 (continued)
Troubleshooting slow data rate speeds

Step Action

3 Check the actual data rates under the connection symbol between
the CCT symbol and the CPE symbol.

4 Use the following table to troubleshoot the problem.

If the actual data rates Then

match the provisioned data
rates

The subscriber loop is operating
correctly.

does not match the
provisioned data rates

Go to step 4.

Possible cause Solution

Temporary noise on line. Wait a few minutes for the noise to clear.

The CPE modem is within
12 inches of a personal
computer (PC).

Ask the subscriber to move the CPE modem
away from the PC.

Subscriber loop is degraded. Analyze the characteristics of the subscriber
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

5 If the problem still exists, contact Nortel Networks technical support.

—end—

For example, the subscriber
loop has permanent line
noise.

loop. Troubleshoot any problems or contact
your next level of support.

Subscriber is transferring
data from a slow Internet site.

Tell the subscriber that the site is operating at
a data rate slower than the data rate of the
CPE modem.

CPE modem or line card has
failed.

• Troubleshoot using Procedure 1-1 on
page 1-21.

• If the problem does not clear, check the
Event Browser for CPE or xDSL LC failure
events. Replace any faulty devices.

Subscriber loop length is
excessive or undesirable
cable makeup

•
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 ATM core card via

munication problems between UE9000
uEMS) and the ATM core card.

ys for you to troubleshoot this type of
p, proceed to the next step only if necessary.

ping the ATM core card. Highlight the ATM
map (see the UE9000 Data OAM&P User
rom the Fault pull-down menu.

erify that the transport network is correctly
 messages.

contact your next level of support.

Then

ard Go to step 3.

e card See Procedure 1-7 on
page 1-43.
Procedure 1-3
uEMS cannot communicate with the
SNMP

Use this procedure to solve com
element management system (

The following steps suggest wa
problem. After completing a ste

Action

Step Action

1 Verify that the uEMS can
core card in the shelf sub
Guide), then select Ping  f

2 If the problem still exists, v
configured to pass SNMP

3 If the problem still exists, 

—end—

If the uEMS

can ping the ATM core c

cannot ping the ATM cor
UE9000 DMS 297-8391-501 NA015
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Procedure 1-4
ATM core card reboots with previous software load

Use this procedure when the ATM core card cannot reboot after a software
upgrade.

Occasionally an ATM core card cannot reboot with an updated ATM core card
software load. Instead, the ATM core card reboots with the previous ATM
core card software load. The following table lists possible causes and
solutions for this problem.

Possible cause Solution

Hewlett Packard workstation trivial
file transfer protocol (TFTP) server
has an invalid software load name
for the ATM core card software.

Verify that the following were
provisioned correctly:

• the directory path for the ATM core
card software

• the new ATM core card software load
name

See the steps in this procedure for
information on how to verify
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

provisioning.

File permissions are incorrect Verify that the ATM card load file and all
the directories along the path allow read
access.

The new ATM core card software
load was corrupted during the file
transfer protocol (FTP) transfer to
the uEMS. The load may have
been transferred in ASCII mode.

Transfer the new ATM core card
software load in binary mode to the
uEMS.

Check logs to confirm a corrupted load
was rejected.

Excessive errors in the transport
network caused the new software
load to fail.

Ask the network administrator about the
integrity of the network.
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ore card software load name is correctly
ore card.

op-up menu, select:

ntory ->Atmif (for DS1 ATM core card)

ntory  (for DS3 ATM core card)

ars.

ventory dialog and check to see if the
me matches the current Atmif load name.

visioned Load  from the pop-up menu.

p dialog appears.

m the list of available loads and click OK.

p dialog disappears. The provisioned load
atabase.

3 ATM core cards in the UE9000 shelf, you
e “standby” DS3 ATM card first, then
“standby” card becomes the “active” card;
 the “standby”). You can then update the
. For more information see Procedure 2-8,

en

o to step 6.

o to step 3.
Procedure 1-4 (continued)
ATM core card reboots with previous software load

Action

Step Action

1 Verify that the new ATM c
provisioned on the ATM c

From the ATM core card p

Show -> ATMIF-DS1 Inve

Show -> ATMIF-DS3 Inve

The Inventory dialog appe

2 Scroll down through the In
provisioned Atmif load na

3 Select Change ATMIF Pro

The Load Selection Pop-u

4 Select the desired load fro

The Load Selection Pop-u
is changed in the uEMS d

Note: If there are two DS
can update the load for th
perform a switch (swact) (
the “active” card becomes
load on the other DS3 card

If Th

yes G

no G
UE9000 DMS 297-8391-501 NA015

“Performing a manual swact on the DS3 ATM core cards” on
page 2-19.

—continued—
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Procedure 1-4 (continued)
ATM core card reboots with previous software load

Step Action

Note: (if there are two DS3 ATM core cards in the UE9000 shelf,
data service is dropped only if a cold restart is performed on the
“active” ATM card.)

5 Perform a restart reload on the ATM card. Select Maintenance ->
Atmif -> Restart -> Reload -> Normal from the pop-up menu. See
Procedure 2-6 on page 2-14 for more information.

6 Verify that a valid software load has been placed on the uEMS
workstation in the correct directory. In a terminal window at the
prompt, type:

cd /etc/opt/OV/share/loads/Nortel/HSTP ↵
ls ↵

CAUTION
Loss of service
When the ATM card performs a restart, all data
traffic on the UE9000 shelf is dropped.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

A list of the software loads in the directory appears. If the file is not
listed, obtain a new copy of it.

7 Check the network connections and the TFTP server on the uEMS
workstation.

8 If the problem still exists, contact your next level of support.

—end—
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ardware flag is displayed over the ATM core
ment management system (uEMS) submap.

ys for you to troubleshoot this type of
p, proceed to the next step only if necessary.

ard hardware is installed and
or installation information, see the UE9000
ce Guide. For commissioning information,
tem Setup Guide.

visioned with the correct IP address for the
0 Data OAM&P User Guide for more

ard is provisioned with the proper uEMS IP
rd IP address. See the UE9000 Data
ore information.

hen

he uEMS has not discovered the ATM
ore card. Go to step 2.

nstall and commission the ATM core card
ardware.
Procedure 1-5
No hardware flag for ATM core card

Use this procedure when a no h
card symbol on any UE9000 ele

The following steps suggest wa
problem. After completing a ste

Action

Step Action

1 Verify that the ATM core c
commissioned properly. F
Installation Quick Referen
see the UE9000 Data Sys

2 Verify that the uEMS is pro
ATM card. See the UE900
information.

3 Verify that the ATM core c
address and the proper ca
System Setup Guide for m

If the ATM core card
hardware is T

installed T
c

not installed I
h

UE9000 DMS 297-8391-501 NA015

4 Verify that the uEMS workstation has IP connectivity to the ATM card
using Procedure 1-7 on page 1-43.

—continued—
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Procedure 1-5 (continued)
No hardware flag for ATM core card

Step Action

Note: If there are two DS3 ATM core cards in the UE9000 shelf, data
service is dropped only if a restart is performed on the “active” ATM
card.

Note: When a DS1 IMA ATM core card is restarted, all provisioning
information is re-passed from the uEMS to the ATM card. The DS3

CAUTION
Loss of service
When the ATM card performs a restart, all data
service on the UE9000 shelf is dropped.

CAUTION
Loss of provisioning
When the ATM card performs a restart, it loses
all provisioning information until uEMS reloads it
after the restart is completed.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

ATM core card, however, includes an on-board non-volatile store.
Because of this, after the DS3 card restarts, a card can come up
completely without uEMS intervention. Instead of all the provisioning
information passing to the Atmif, only the changes are sent, allowing
for a faster recovery time. For more information, see Procedure 2-7,
“Updating Recovery Data” on page 2-17.

5 Cold restart the ATM core card by selecting:

Maintenance -> Atmif -> Restart -> Cold  (for DS1 ATM)

Maintenance ->Restart -> Cold  (for DS3 ATM)

The ATM card restarts.

Note: If this command is not accepted, go to step 6.

—continued—
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3 ATM core cards in the UE9000 shelf, data
a restart is performed on the “active” ATM

.

rd. See Procedure 2-11 on page 2-29.

contact your next level of support.

ION
 service
ting an ATM core card drops data service
DSL line cards in the UE9000 shelf.

ION
 communication
ing an ATM core card changes the media
 control (MAC) address of the ATM core
ata network devices, such as routers,
e updated with the MAC address of the
M core card. If the data network devices

t updated, communication with the ATM
rd is lost. Inform your network

strator of the new MAC address for the
ore card.
Procedure 1-5 (continued)
No hardware flag for ATM core card

Step Action

Note: If there are two DS
service is dropped only if 
card.

6 Reseat the ATM core card

7 Replace the ATM core ca

8 If the problem still exists, 

—end—

CAUT
Loss of
Resea
on all x

CAUT
Loss of
Replac
access
card. D
must b
new AT
are no
core ca
admini
ATM c
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Procedure 1-6
xDSL fails loopback test

Use this procedure when an xDSL line card fails a loopback test.

Note: It is assumed in this procedure that other xDSL line cards on the
shelf are functioning properly.

Action

Step Action

1 If an xDSL line card fails a loopback test, perform the loopback test
again.

If the xDSL Then

fails the loopback test Go to step 2.

passes the loopback test End the procedure.

CAUTION
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

2 From the xDSL line card pop-up menu, select:

Maintenance ->LC -> Restart -> Cold

The xDSL line card restarts.

—continued—

Loss of service
When the xDSL line card performs a Cold,
Normal Load, or Forced Load restart, all voice
and data service on the xDSL line card is
dropped.

CAUTION
Loss of provisioning
When the xDSL line card performs a cold restart,
it loses all provisioning information until uEMS
reloads it after the cold restart is completed.
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 If the test fails, go to step 4.

 and repeat the loopback test. If the test

op-up menu, select:

k -> Normal

 of service.

rd and manually change the state to

ION
 service
ing an xDSL line card drops voice and
rvice on all subscriber circuits on that line

ION
 service
moving the line card from the shelf, you
ait more than five seconds before you
t the line card. If you do not wait more than
conds to reinsert the card, the line card
p all voice and data service for five to
inutes.
Procedure 1-6 (continued)
xDSL fails loopback test

Step Action

3 Repeat the loopback test.

4 Reseat the xDSL line card
fails, go to step 5.

5 From the xDSL line card p

Maintenance ->LC ->Loc

The xDSL line card is out

6 Replace the xDSL line ca
in-service (unlocked).

—continued—

CAUT
Loss of
Remov
data se
card.

CAUT
Loss of
After re
must w
reinser
five se
can dro
eight m
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Procedure 1-6 (continued)
xDSL fails loopback test

Step Action

7 Repeat the loopback test. If the test fails, go to step 5.

Note 1: If there are two DS3 ATM core cards in the UE9000 shelf,
data service is dropped only if a restart is performed on the “active”
ATM card.

Note 2: When a DS1 IMA ATM core card is restarted, all provisioning
information is re-passed from the uEMS to the ATM card. The DS3
ATM core card, however, includes an on-board non-volatile store.
Because of this, after the DS3 card restarts, a card can come up
completely without uEMS intervention. Instead of all the provisioning
information passing to the Atmif, only the changes are sent, allowing
for a faster recovery time. For more information, see Procedure 2-7,
“Updating Recovery Data” on page 2-17.

CAUTION
Loss of service
When the ATM card performs a restart, all data
service on the UE9000 shelf is dropped.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

8 From the ATM symbol pop-up menu, select:

Maintenance -> Atmif -> Restart -> Cold  (for DS1 ATM)

Maintenance -> Restart -> Cold  (for DS3 ATM

The ATM card restarts.

—continued—
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3 ATM core cards in the UE9000 shelf, data
a restart is performed on the “active” ATM

.

replace the ATM core card. See
-29.

contact your next level of support.

ION
 service
ting an ATM core card drops data service
DSL line cards in the UE9000 shelf.

ION
 communication
ing an ATM core card changes the media
 control (MAC) address of the ATM core
ata network devices, such as routers,
e updated with the MAC address of the
M core card. If the data network devices

t updated, communication with the ATM
rd is lost. Inform your network

strator of the new MAC address for the
ore card.
Procedure 1-6 (continued)
xDSL fails loopback test

Step Action

Note: If there are two DS
service is dropped only if 
card.

9 Reseat the ATM core card

10 If the problem still exists, 
Procedure 2-11 on page 2

11 If the problem still exists, 

—end—

CAUT
Loss of
Resea
on all x

CAUT
Loss of
Replac
access
card. D
must b
new AT
are no
core ca
admini
ATM c
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Procedure 1-7
Verify uEMS workstation has IP connectivity to the ATM
core card

Use the following procedure to verify that the uEMS workstation has basic
connectivity to the ATM card. This is a prerequisite for SNMP access and file
transfer of software update.

Probable cause
The ATM core card is not installed or is faulty, or the IP network between the
uEMS and ATM core card is down.

Action

Step Action

1 Verify that the ATM core card hardware is installed and has been
commissioned. See the UE9000 Data System Setup Guide for more
information.

2 Verify that the uEMS can ping the ATM core card. Highlight the ATM
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

core card in the shelf submap (see the UE9000 Data OAM&P User
Guide), then select:

Fault -> Ping

The Ping dialog box appears.

—continued—

If the uEMS Then

can ping the ATM core
card

There is basic IP connectivity to the
ATM card. You are finished with this
procedure.

cannot ping the ATM core
card

Go to step 3.
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 ATM core card

t ATM card. Highlight a different ATM core
(see the UE9000 Data OAM&P User

ars.

d to the subject ATM card provisioned

ard local craft interface (LCI) port (see the
up Guide for more information). Are the IP
teway address, and VPI/VCI provisioned
f-band management properly configured?

 is basic IP connectivity to the ATM
rk. Go to step 4.

 is a network IP connectivity problem.
ify and fix.

ovisioning. See the UE9000 Data OAM&P
r more information.
Procedure 1-7 (continued)
Verify uEMS workstation has IP connectivity to the

Step Action

3 Attempt to ping a differen
card in the shelf submap 
Guide), then select:

Fault -> Ping

The Ping dialog box appe

4 Is the IP address assigne
correctly in uEMS?

5 Connect to the ATM core c
UE9000 Data System Set
address, subnet mask, ga
correctly? Is inband/out-o

If the uEMS Then

can ping the ATM
core card

There
netwo

cannot ping the
ATM core card

There
Ident

If Then

yes Go to step 5.

no Correct the pr
User Guide fo

Go to step 1.

If Then
UE9000 DMS 297-8391-501 NA015

—continued—

yes Go to step 6.

no Correct the provisioning using the LCI connection.

Go to step 1.
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Procedure 1-7 (continued)
Verify uEMS workstation has IP connectivity to the ATM core card

Step Action

6 At the uEMS workstation, open a terminal window and issue a trace
route to the IP address of the ATM card. This indicates how far the
uEMS has IP connectivity toward the ATM card.

If the trace route
indicates Then

connectivity to the
gateway router at the
ATM network

the uEMS and the uEMS LAN are
functioning correctly. The problem is likely
within the ATM network. Isolate and
correct the fault.

no access to the
gateway router

the problem is likely within the uEMS LAN
segment to the gateway. Isolate and
correct the fault.

CAUTION
Loss of communications
If you are using a DS1 IMA ATM card, ensure
that the far end equipment does not have
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note: Scrambling is supported on UE9000 shelves equipped with
the DS3 ATM core card(s).

7 If the problem still exists, then the ATM is either faulty or provisioned
incorrectly, or a cabling or facilities problem exists at the site.
Investigate and correct these issues.

—end—

scrambling enabled on the IMA interface.
Scrambling is an ATM parameter that UE9000
equipment does not support over the DS1 IMA
links because it is not required at T1 speeds. If
scrambling is enabled over the DS1 IMA links,
the ATM cells experience payload corruption,
resulting in CRC errors at the CPE.
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the uEMS workstation

oot when the ATM core card is not sending
anagement system (uEMS) workstation.

ys for you to troubleshoot this type of
p, proceed to the next step only if necessary.

ping the ATM core card. Highlight the ATM
map (see the UE9000 Data OAM&P User

ars.

t mask, and gateway address assigned to
isioned correctly in uEMS?

Then

ard Go to step 3.

e card Go to step 2.

. If the problem still exists, go to
 on page 1-43.

ovisioning. See the UE9000 Data OAM&P
Procedure 1-8
ATM core card is not sending traps to

Use this procedure to troublesh
traps to the UE9000 element m

The following steps suggest wa
problem. After completing a ste

Action

Step Action

1 Verify that the uEMS can
core card in the shelf sub
Guide), then select:

Fault -> Ping

The Ping dialog box appe

2 Are the IP address, subne
the subject ATM card prov

If the uEMS

can ping the ATM core c

cannot ping the ATM cor

If Then

yes Repeat step 1
Procedure 1-7

no Correct the pr
UE9000 DMS 297-8391-501 NA015

—continued—

User Guide for more information.

Go to step 1.
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Procedure 1-8 (continued)
ATM core card is not sending traps to the uEMS workstation

Step Action

3 Verify that the ATM card can communicate with uEMS using SNMP.
From the pull-down menu, select:

Fault -> Nortel uEMS -> verify com

4 The ATM card should be sending traps to uEMS. If no traps are being
sent, go to step 6.

5 Verify that the ATM card has been provisioned with the correct IP
address for the uEMS workstation. See the UE9000 Data System
Setup Guide for more information.

Was the test successful? Then

yes Go to step 4.

no Go to step 5.

CAUTION
Loss of service
Restarting an ATM core card drops data service
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note: If there are two DS3 ATM core cards in the UE9000 shelf, data
service is dropped only if a restart is performed on the “active” ATM
card.

6 Perform a restart reload on the ATM card. Select Maintenance ->
Atmif -> Restart -> Reload -> Normal from the pop-up menu. See
Procedure 2-6 on page 2-14 for more information.

Note: If there are two DS3 ATM core cards in the UE9000 shelf, you
can update the load for the “standby” DS3 ATM card first, then
perform a switch (swact) (“standby” card becomes the “active” card;
the “active” card becomes the “standby”). You can then update the
load on the other DS3 card. For more information see Procedure 2-8,
“Performing a manual swact on the DS3 ATM core cards” on
page 2-19.

7 If the problem still exists, contact your next level of support.

—end—

on all xDSL line cards in the UE9000 shelf.
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rd

 over the xDSL line card symbol on any
ent system (uEMS) submap

 xDSL line card

the uEMS submap

with incorrect information

ard is properly seated.

s properly seated.

ION
 service
ust wait more than five seconds to reinsert
ard after removing the line card from the
reseat it. If you do not wait more than five
s, the line card can drop all voice and data
 for five to eight minutes.

en

o to step 2.

eseat the xDSL line card. If the problem
ntinues, go to step 3.
Procedure 1-9
No hardware flag for an xDSL line ca

Use this procedure when

• a no hardware flag appears
UE9000 element managem

• the uEMS cannot detect an

— xDSL disappears from 

— xDSL symbol appears 

Action

Step Action

1 Verify that the xDSL line c

2 Verify that the TDM card i

CAUT
Loss of
You m
a line c
shelf to
second
service

If the xDSL is Th

properly seated G

not properly seated R
co
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—continued—

If the TDM card is Then

properly seated Go to step 3.

not properly seated Reseat the TDM card. If the problem
continues, go to step 3.
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Procedure 1-9 (continued)
No hardware flag for an xDSL line card

Step Action

3 Check that the line card in the slot is an xDSL line card and not a
voice-only line card.

4 If the problem continues, contact your next level of technical support.

—end—

If the line card in the
slot is Then

an xDSL line card Using the pop-up menu, put the xDSL line
card out-of-service (lock) and replace the
xDSL line card. Put the xDSL line card
in-service (unlock).

voice-only line card Replace the voice-only line card with an
xDSL line card. Using the pop-up menu, put
the xDSL line card in-service (unlock).
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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whether an ATM core card is faulty.

TM core cards in the UE9000 shelf, one is
, one is designated the “standby” card. In the
re failure, or loss of service (LOS), loss of

rm indication (RAI), the “standby” card
ctive” card and takes over (auto-swact).

ge while the newly active DS3 ATM card
e previously active configuration. Service
atically.

een the ATM and the UE9000 element
S) workstation?

ION
 service
ting an ATM drops data service on all
ine cards in the UE9000 shelf.

 ATM. If the ATM does not function
step 2.

1-7 on page 1-43 to evaluate the problem.
Procedure 1-10
Troubleshooting an ATM core card

Use this procedure to evaluate 

Note: If there are two DS3 A
designated the “active” card
event of a DS3 card hardwa
frame (LOF), or remote ala
detects the failure of the “a

There will be a service outa
configures itself to match th
will then be restored autom

Action

Step Action

1 Is communication up betw
management system (uEM

CAUT
Loss of
Restar
xDSL l

If Then

yes Cold restart the
correctly, go to

no Use Procedure
UE9000 DMS 297-8391-501 NA015

—continued—

If the ATM continues to act faulty after communication
between the uEMS workstation and the ATM is restored,
cold restart the ATM. If the ATM still does not function
correctly, go to step 2.
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Procedure 1-10 (continued)
Troubleshooting an ATM core card

Step Action

2 Reseat the ATM. If the ATM does not function correctly, go to step 3.

CAUTION
Loss of service
Reseating an ATM drops data service on all
xDSL line cards in the UE9000 shelf.

CAUTION
Loss of communications
If you are using a DS1 IMA ATM card, ensure
that the far end equipment does not have
scrambling enabled on the IMA interface.
Scrambling is an ATM parameter that UE9000
equipment does not support over the DS1 IMA
links because it is not required at T1 speeds. If
scrambling is enabled on the DS1 IMA links, the
ATM cells experience payload corruption,
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note: Scrambling is supported on UE9000 shelves equipped with
the DS3 ATM core card(s).

3 Replace the ATM. See Procedure 2-11 on page 2-29 for information
on how to replace the ATM.

—end—

resulting in CRC errors at the CPE.
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ize the alarm database with the uEMS
rebuilds the alarm database if it is missing.

r open or closed when this command is issued.
 press the refresh button or wait 60 seconds
r.

ffecting and can be followed at any time.

and from a uEMS screen:

ynchronize Alarm Browser

 appears when the alarm database is

isappears and the alarm browser functions
Procedure 1-11
Synchronizing the alarm database

Use this procedure to synchron
database. This procedure also 

The alarm browser can be eithe
However, if it is open, you must
for an automatic refresh to occu

This procedure is not service a

Action

Step Action

1 Issue the following comm

Misc -> Nortel uEMS -> S

A confirmation dialog box
synchronized.

2 Click OK.

The confirmation dialog d
normally.

—end—
UE9000 DMS 297-8391-501 NA015
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UE9000 D

Hardware management 2-

This chapter includes procedures for managing the hardware on the Universal
Edge 9000 (UE9000) system.

See theUE9000 Data OAM&P User Guidefor information on upgrading the
software loads in the ATM card and the xDSL line card.

Chapter contents
This chapter contains the following tasks:

Task See

Inventorying UE9000 components Procedure 2-1 on page 2-3
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Changing the operational state of an ATM
core card

Procedure 2-2 on page 2-4

Changing the operational state of a DS1
carrier

Procedure 2-3 on page 2-6

Changing the operational state of xDSL
multi-circuit line cards

Procedure 2-4 on page 2-8

Changing the operational state of xDSL
subscriber circuits

Procedure 2-5 on page 2-11

Restarting an ATM core card Procedure 2-6 on page 2-14

Updating Recovery Data Procedure 2-7 on page 2-17

Performing a manual swact on the DS3 ATM
core cards

Procedure 2-8 on page 2-19

Restarting an xDSL multi-circuit line card Procedure 2-9 on page 2-20

—continued—
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Procedure 2-10 on page 2-23

Procedure 2-11 on page 2-29

e card Procedure 2-12 on page 2-32

—end—

See
Upgrading the firmware

Replacing an ATM core card

Replacing an xDSL multi-circuit lin

Task
UE9000 DMS 297-8391-501 NA015
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Procedure 2-1
Inventorying UE9000 components

Use this procedure to inventory UE9000 components using the UE9000
element management system (uEMS) graphical user interface (GUI).

The inventory command inventories only those components hierarchically
beneath the UE9000 component where the inventory command was selected.

For example, if you are in the Root submap and use the HSTP-Network
symbol’s pop-up menu to select inventory, all UE9000 components in the data
network will be inventoried. If you are in the Shelf submap and use the ATM
core card symbol’s pop-up menu to select inventory, then only the ATM card
and the carriers associated with it are inventoried.

Action

Step Action

1 Go to any uEMS GUI submap (see the UE9000 Data OAM&P User
Guide). From any symbol’s pop-up menu, select Show -> Inventory ,
then the UE9000 component you want to inventory.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note: If you want to inventory all UE9000 components, select Show
-> Inventory  -> All  from the HSTP network symbol pop-up menu.

The Inventory dialog appears listing all UE9000 components.

2 When you are finished with the Inventory dialog, click the Close
button.

—end—
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 ATM core card

e operational state of an ATM core card using
ent system (uEMS) graphical user interface

ect before you can unprovision it.

ee the UE9000 Data OAM&P User Guide).

ION
 service
the ATM core card is put in the Lock state,
a service on the UE9000 shelf is dropped.
Procedure 2-2
Changing the operational state of an

Use this procedure to change th
the UE9000 element managem
(GUI).

Note: You must lock an obj

Action

Step Action

1 Go to the Shelf submap (s
\

—continued—

CAUT
Loss of
When
all dat
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Procedure 2-2 (continued)
Changing the operational state of an ATM core card

Step Action

2 From the ATM core card’s pop-up menu, select:

Maintenance -> Atmif -> [state] -> [method]  (for DS1 ATM)

Maintenance -> [state] -> [method]  (for DS3 ATM)

where

[state] is the operational state

Unlock  is in-service
Lock  is out-of-service

[method] is how the state is achieved

Normal  is performed at the earliest convenient
time.

Force  is performed immediately regardless of
the traffic load or condition. If there is no
communication between the uEMS and the ATM
core card, the change is saved in the uEMS
database and will take effect after
communication has been restored.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

The ATM core card changes to the indicated operational state.

—end—

In this case, uEMS attempts to make the change
at intervals defined by the Network Polling
Configuration in the HPOV Options menu.
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DS1 carrier

e operational state of a DS1 carrier using the
ystem (uEMS) graphical user interface (GUI).

 you can unprovision it.

 1 and 2 are always the IMA timing
ocked or unprovisioned.

ap (see the UE9000 Data OAM&P User

ION
 service
g a DS1 carrier will reduce the available
idth of the IMA group proportionately,
ay result in a momentary loss of data.
Procedure 2-3
Changing the operational state of a 

Use this procedure to change th
UE9000 element management s

You must lock an object before

Note: DS1 carrier numbers
references and cannot be l

Action

Step Action

1 Go to the ATM card subm
Guide).

—continued—

CAUT
Loss of
Lockin
bandw
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Procedure 2-3 (continued)
Changing the operational state of a DS1 carrier

Step Action

2 From the DS1 carrier’s pop-up menu, select:

Maintenance -> [state] -> [method]

where

[state] is the operational state

Unlock  is in-service
Lock  is out-of-service

[method] is how the state is achieved

Normal is performed at the earliest convenient
time.

Force is performed immediately regardless of
the traffic load or condition. If there is no
communication between the uEMS and the
ATM core card, the change is saved in the
uEMS database and will take effect after
communication has been restored.

In this case, uEMS attempts to make the
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

The DS1 carrier changes to the indicated operational state.

—end—

change at intervals defined by the Network
Polling Configuration in the HPOV Options
menu.
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SL multi-circuit line

he operational state of one or all xDSL
ing the UE9000 element management

interface (GUI).

ect before you can unprovision it.

ne xDSL multi-circuit line card:

ee the UE9000 Data OAM&P User Guide).

perational Then

go to step 1

e time go to step 5

ION
 service
g an xDSL MLC will cause loss of all
ervice on all subscriber circuits on that
Procedure 2-4
Changing the operational state of xD
cards

Use this procedure to change t
multi-circuit line cards (MLC) us
system (uEMS) graphical user 

Note: You must lock an obj

Action

Step Action

Changing the operational state of o

1 Go to the Shelf submap (s

—continued—

If you are changing the o
state of

one xDSL MLC

all xDSL MLCs at the sam

CAUT
Loss of
Lockin
data s
MLC.
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Procedure 2-4 (continued)
Changing the operational state of xDSL multi-circuit line cards

Step Action

2 Right -click on the object.

3 From the xDSL MLC’s pop-up menu, select:

Maintenance -> [xDSL] -> [state] -> [method]

where

[state] is the operational state

Unlock  is in-service
Lock  is out-of-service

[method] is how the state is achieved

Normal  is performed at the earliest
convenient time.

Force is performed immediately regardless of
the traffic load or condition. If there is no
communication between the uEMS and the
line card, the change is saved in the uEMS
database and will take effect after
communication has been restored.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

4 When locking, on the popup window press the OK button to confirm,
or the Cancel  button to cancel the action.

The xDSL MLC changes to the indicated operational state.

Changing the operational state of all xDSL multi-circuit line cards:

5 Go to the Network Element submap.

6 Select the shelf.

7 Right click on the mouse and hold.

8 From the xDSL MLC’s menu, select:

Maintenance -> [xDSL] -> [state] -> [method]

—continued—

In this case, uEMS attempts to make the
change at intervals defined by the Network
Polling Configuration in the HPOV Options
menu.
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it line cards

up window press the OK button to confirm,
ncel the action.
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Procedure 2-4 (continued)
Changing the operational state of xDSL multi-circu

Step Action

9 When locking, on the pop
or the Cancel  button to ca

The xDSL MLC changes 

—end—
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Procedure 2-5
Changing the operational state of xDSL subscriber circuits

Use this procedure to change the operational state of one or all xDSL
subscriber circuit using the UE9000 element management system (uEMS)
graphical user interface (GUI).

Note: You must lock an object before you can unprovision it.

Action

Step Action

Changing the operational state of one xDSL subscriber circuit:

If you are changing the
operational state of

Then

one xDSL subscriber circuit go to step 1

all xDSL subscriber circuits at the
same time

go to step 4
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

1 Go to the LC submap (see the UE9000 Data OAM&P User Guide).

—continued—

CAUTION
Loss of service
When the xDSL subscriber circuit is put in the
Lock state, all data service on the xDSL
subscriber circuit is dropped.
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 circuits

r circuit’s pop-up menu, select:

 [state] -> [method]

up window press the OK button to confirm,
ncel the action.

uit changes to the indicated operational

ll xDSL subscriber circuits:

is the operational state

Unlock  is in-service
Lock  is out-of-service

is how the state is achieved

Normal  is performed at the earliest
convenient time.

Force  is performed immediately
regardless of the traffic load or condition.
If there is no communication between the
uEMS and the line card, the change is
saved in the uEMS database and will
take effect after communication has been
restored.

In this case, uEMS attempts to make the
change at intervals defined by the
Network Polling Configuration in the
HPOV Options menu.
Procedure 2-5 (continued)
Changing the operational state of xDSL subscriber

Step Action

2 From the xDSL subscribe

Maintenance -> Circuit ->

3 When locking, on the pop
or the Cancel  button to ca

The xDSL subscriber circ
state.

Changing the operational state of a

4 Go to the LC submap.

where

[state]

[method]
UE9000 DMS 297-8391-501 NA015

5 Select the LC.

6 Right click on the mouse and hold.

—continued—
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Procedure 2-5 (continued)
Changing the operational state of xDSL subscriber circuits

Step Action

7 From the xDSL subscriber circuit’s menu, select:

Maintenance -> Circuit -> [state] -> [method]

where

[state] is the operational state

All Unlock  is in-service
All Lock  is out-of-service

[method] is how the state is achieved

Normal  is performed at the earliest
convenient time.

Force  is performed immediately
regardless of the traffic load or condition.
If there is no communication between the
uEMS and the line card, the change is
saved in the uEMS database and will
take effect after communication has been
restored.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

8 When locking, on the popup window press the OK button to confirm,
or the Cancel  button to cancel the action.

The xDSL MLC changes to the indicated operational state.

The xDSL subscriber circuit changes to the indicated operational
state.

—end—

In this case, uEMS attempts to make the
change at intervals defined by the
Network Polling Configuration in the
HPOV Options menu.
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ATM core card using the Universal Edge 9000
uEMS) graphical user interface (GUI). To
entire shelf or NE, seeProcedure 2-10 on

TM core cards in the UE9000 shelf, you can
ndby” DS3 ATM card first, then perform a
mes the “active” card; the “active” card
u can then update the load on the other DS3
seeProcedure 2-8, “Performing a manual
 cards” on page 2-19.

s of restarts:Cold, Reload Normal, and
e described below.

to reset and then reload itself with the load
sh memory. During a cold restart, the card
n. However, the uEMS sends the
ard after the reload is complete.

M core card is restarted, all provisioning
m the uEMS to the ATM card. The DS3 ATM
s an on-board non-volatile store. Because of
tarts, a card can come up completely without
of all the provisioning information passing to
are sent, allowing for a faster recovery time.
cedure 2-7, “Updating Recovery Data” on

the card to compare its current load with the
Procedure 2-6
Restarting an ATM core card

Use this procedure to restart an
element management system (
upgrade all the firmware on an 
page 2-23.

Note: If there are two DS3 A
update the load for the “sta
swact (“standby” card beco
becomes the “standby”). Yo
card. For more information 
swact on the DS3 ATM core

The uEMS supports these type
Reload Force. These options ar

A Cold restart causes the card 
currently stored in the card’s fla
loses its provisioning informatio
provisioning information to the c

Note: When a DS1 IMA AT
information is re-passed fro
core card, however, include
this, after the DS3 card res
uEMS intervention. Instead
the Atmif, only the changes
For more information, seePro
page 2-17.

A restartReload Normalcauses
UE9000 DMS 297-8391-501 NA015

load provisioned in uEMS. If the loads are the same, the card performs a cold
restart. If the loads are different, the card performs a restart reload force.

A restartReload Force causes uEMS to load the card with the provisioned
load, regardless of what the card’s current load is. The card then performs a
cold restart.

—continued—
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Procedure 2-6 (continued)
Restarting an ATM core card

Action

Step Action

1 Go to the Shelf submap (see the UE9000 Data OAM&P User Guide).

2 From the ATM card’s pop-up menu, select:

Maintenance -> Atmif -> Lock -> Normal (for DS1 ATM)

Maintenance -> Lock -> Normal (for DS3 ATM)

The ATM card becomes out-of-service (subscriber traffic stops, but
alarms can be generated).

Note: When a DS1 IMA ATM core card is restarted, all provisioning

CAUTION
Loss of service
When the ATM core card is put in the Lock state,
all data service on the UE9000 shelf is dropped.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

information is re-passed from the uEMS to the ATM card. The DS3
ATM core card, however, includes an on-board non-volatile store.
Because of this, after the DS3 card restarts, a card can come up
completely without uEMS intervention. Instead of all the provisioning
information passing to the Atmif, only the changes are sent, allowing
for a faster recovery time. For more information, see Procedure 2-7,
“Updating Recovery Data” on page 2-17.

—continued—
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up menu, select:

estart -> Cold  (for DS1 ATM)

 Cold (for DS3 ATM)

e “restart cold” annotation text disappears

 (Cold , Reload Normal , Reload Force )
at you are trying to accomplish. Refer to the
sed in the beginning of Procedure 2-6 on

up menu, select:

nlock -> Normal (for DS1 ATM)

 Normal (for DS3 ATM)

e.
Procedure 2-6 (continued)
Restarting an ATM core card

Step Action

3 From the ATM card’s pop-

Maintenance -> Atmif -> R

Maintenance -> Restart ->

The ATM card restarts. Th
from the symbol.

Note: The type of restart
you select depends on wh
restart descriptions discus
page 2-14.

4 From the ATM card’s pop-

Maintenance -> Atmif -> U

Maintenance -> Unlock ->

The ATM card is in servic

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 2-7
Updating Recovery Data

When a DS1 IMA ATM core card is restarted, all provisioning information is
re-passed from the uEMS to the ATM card. The DS3 ATM core card,
however, includes an on-board non-volatile store. The DS3 provisioning
information is synchronized automatically every 24 hours. Because of this,
after the DS3 card restarts, a card can come up completely without uEMS
intervention. Instead of all the provisioning information passing to the Atmif,
only the last 24-hour changes are sent, allowing for a faster recovery time.

The Update Recovery Data is pushed up to the DS3 ATM core card(s)
automatically. This is set up as a cron job that runs daily at 1:00 a.m.

You can also manually update the latest configuration information. Use this
procedure to manually update the latest configuration data to the DS3 ATM
core cards.

Action

Step Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

1 Go to the Shelf submap (see the UE9000 Data OAM&P User Guide).

2 Choose one of the following:

—continued—

If you want to Then

transfer the configuration file to the ATM core
card without restarting the ATM card (will not
interrupt data traffic)

go to step 3

transfer the configuration file to the ATM core
card and then restart the ATM card after the
transfer (will interrupt data traffic)

go to step 5
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up menu, select:

ecovery Data ->No Reboot

ears.

ansferred to the ATM core card.

procedure.

up menu, select:

ecovery Data ->With Reboot

ears.

tion is transferred to the ATM core card.
lete, the ATM card is restarted.

estart  button in the confirmation dialog.
on will re-transfer the configuration file and
rt.

procedure.
Procedure 2-7 (continued)
Updating Recovery Data

Step Action

3 From the ATM card’s pop-

Maintenance ->Update R

A Confirmation dialog app

4 Select OK.

The configuration file is tr

You are finished with this 

5 From the ATM card’s pop-

Maintenance ->Update R

A Confirmation dialog app

6 Select OK.

The configuration informa
Once the transfer is comp

Note: Do not select the R
Selecting the Restart butt
trigger another card resta

You are finished with this 

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 2-8
Performing a manual swact on the DS3 ATM core cards

If there are two DS3 ATM core cards in the UE9000 shelf, one is designated
the “active” card, one is designated the “standby” card. In the event of a DS3
card hardware failure, or loss of service (LOS), loss of frame (LOF), or
remote alarm indication (RAI), the “active” card detects the failure and sends
a signal to the “standby” (auto-swact).

There is a five to six minute data outage while the newly active DS3 ATM core
card configures itself to match the previously active configuration. Service
will then be restored automatically.

You can also choose to manually perform a swact.Use this procedure to
perform a manual swact on the DS3 ATM core cards.

Action

Step Action

1 Go to the Shelf submap (see the UE9000 Data OAM&P User Guide).
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

2 Update the provisioning information. See Procedure 2-7, “Updating
Recovery Data” on page 2-17.

3 From the ATM card’s pop-up menu, select:

Maintenance -> Swact

A dialog box appears, asking if you are sure you perform the swact.

4 Select OK.

When the swact is complete, a message appears saying the
appropriate DS3 ATM card (DAC A or DAC B) is now active and
configuring.

Note: A swact on a fully-loaded UE9000 shelf can take up to 6
minutes.
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 card

xDSL multi-circuit line card (MLC) using the
ystem (uEMS) graphical user interface (GUI).
an entire shelf or NE, seeProcedure 2-10 on

s of restarts:Cold, Reload Normal, and
e described below.

 to reset and then reload itself with the load
sh memory. During a cold restart, the card
n. However, the uEMS sends the
ard after the reload is complete.
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f the loads are the same, the card performs a
erent, the card performs a restart reload.

uEMS to load the card with the provisioned
d’s current load is. The card then performs a

 ATM core card is restarted before the
ownload does not resume. Therefore, always
ish before restarting the ATM core card.

e DSP firmware downloaded to the LC is
 currently in use, an additional five minutes
DSP flash memory with the new firmware.

ad, the LC symbol displays “ATUC
ou can also check the Event Browser for
Procedure 2-9
Restarting an xDSL multi-circuit line

Use this procedure to restart an
UE9000 element management s
To upgrade all the firmware on 
page 2-23.

The uEMS supports these type
Reload Force. These options ar

A Restart Cold causes the card
currently stored in the card’s fla
loses its provisioning informatio
provisioning information to the c

A Restart Reloadnormal causes
load provisioned in the uEMS. I
cold restart. If the loads are diff

A Restart Reload Forcecauses
load, regardless of what the car
cold restart.

Note: If, for any reason, the
download is complete, the d
wait for the download to fin

On the ADSL 4+4 line card, if th
different from the DSP firmware
will be required to upgrade the 

Note: During a DSP downlo
Loading” annotation text. Y
UE9000 DMS 297-8391-501 NA015

messages indicating the start or completion of a line card download.

—continued—
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Procedure 2-9 (continued)
Restarting an xDSL multi-circuit line card

Action

Step Action

1 Go to the Shelf submap (see the UE9000 Data OAM&P User Guide).

2 From the xDSL MLC’s pop-up menu, select:

Maintenance -> [xDSL] -> Lock -> Normal

3 Press the OK button to confirm, or the Cancel  button to cancel the
action.

The line card is locked.

CAUTION
Loss of service
The data service resumes once the xDSL MLC
has completed a reset and has re-established
the link with the remote CPE modem.

CAUTION
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

4 From the xDSL MLC’s pop-up menu, select:

Maintenance -> [xDSL] -> Restart -> Cold

Note: In addition to Cold, other options for this step are Reload
Normal and Reload Force. See descriptions of each at the beginning
of Procedure 2-9 on page 2-20.

5 Press the OK button to confirm, or the Cancel  button to cancel the
action.

The xDSL MLC restarts.

—continued—

Time delay
Line card loads that include a new digital signal
processor (DSP) load require an additional five
minutes to complete.

Note: This additional delay is only applicable to
a Restart->Reload.
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p-up menu, select:

 Unlock -> Normal
Procedure 2-9 (continued)
Restarting an xDSL multi-circuit line card

Step Action

6 From the xDSL MLC’s po

Maintenance -> [xDSL] ->

The line card is unlocked.

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 2-10
Upgrading the firmware

Use this procedure to send the software loads that have been provisioned from
the uEMS workstation to the equipment.

Action

Step Action

1 What are you upgrading?

If you are upgrading the
firmware on

Then

one xDSL MLC go to step 2.

one ATM core card go to step 9.

all cards of one type in one shelf go to step 15.

all cards of all types in one shelf go to step 21.

all the firmware on an NE go to step 26.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Upgrading the firmware on a single multi-circuit line card

2 Go to the shelf submap (see the UE9000 Data OAM&P User Guide).

3 From the xDSL MLC’s pop-up menu, select:

Maintenance ->Show ->[xDSL] LC Inventory

The Inventory dialog appears.

—continued—

CAUTION
Loss of service
Upgrading the firmware on a line card drops all
data service for that line card for the duration of
the upgrade.
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Procedure 2-10 (continued)
Upgrading the firmware

Step Action

4 Scroll down through the In
provisioned LC load name
the current load name ma

5 From the xDSL MLC’s po

Change [xDSL] LC Provis

The Load Selection Pop-u

6 Select the desired load fro

The Load Selection Pop-u
is changed in the uEMS d

7 Perform a restart reload n
Procedure 2-9, “Restartin
page 2-20 for more inform

8 You are finished with this 

Upgrading the firmware on a single

If Th

yes yo

no go

CAUT
Loss of
Upgrad
drops a
of the u
UE9000 DMS 297-8391-501 NA015

Note: If there are two DS3 ATM core cards in the UE9000 shelf, you
can update the load for the “standby” DS3 ATM card first, then
perform a swact (“standby” card becomes the “active” card; the
“active” card becomes the “standby”). You can then update the load
on the other DS3 card. For more information see Procedure 2-8,
“Performing a manual swact on the DS3 ATM core cards” on
page 2-19.

—continued—
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Procedure 2-10 (continued)
Upgrading the firmware

Step Action

9 Go to the shelf submap (see the UE9000 Data OAM&P User Guide).

From the ATM core card pop-up menu, select:

Show -> ATMIF-DS1 Inventory ->Atmif (for DS1 ATM core card)

Show -> ATMIF-DS3 Inventory  (for DS3 ATM core card)

The Inventory dialog appears.

10 Scroll down through the Inventory dialog and check to see if the
provisioned Atmif load name matches the current Atmif load name.
Does the current load name match the desired load name?

11 Select Change ATMIF Provisioned Load  from the pop-up menu.

The Load Selection Pop-up dialog appears.

If Then

yes you are finished with this procedure..

no go to step 11.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

12 Select the desired load from the list of available loads and click OK.

The Load Selection Pop-up dialog disappears. The provisioned load
is changed in the uEMS database.

13 Perform a restart reload normal on the ATM core card. See
Procedure 2-6, “Restarting an ATM core card” on page 2-14 for more
information.

14 You are finished with this procedure.

—continued—
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 of one type in one shelf

ee the UE9000 Data OAM&P User Guide).
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ears.
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p dialog disappears. The provisioned load
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ION
 service
upgrading the firmware on multiple line
the cards are updated individually in a
tial fashion. Data service is dropped only
line card currently being updated, for the
n of the upgrade.

Upgrading the firmware on an ATM core
ops all data service on that shelf for the
n of the upgrade.
Procedure 2-10 (continued)
Upgrading the firmware

Step Action

Upgrading the firmware of all cards

15 Go to the shelf submap (s

16 From the shelf pop-up me

Attribute change -> All [AT

A Confirmation dialog app

17 Click OK.

The Load Selection Popu

18 Select the desired load fro

The Load Selection Pop-u
is changed in the uEMS d

19 Perform a restart reload n
Procedure 2-6, “Restartin
Procedure 2-9, “Restartin
page 2-20.

CAUT
Loss of
When 
cards, 
sequen
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duratio

Note:
card dr
duratio
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20 You are finished with this procedure.

—continued—
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Procedure 2-10 (continued)
Upgrading the firmware

Step Action

Upgrading the firmware on all cards of all types in one shelf

21 Repeat steps 15 through 18 for each ATM core card, and each xDSL
MLC.

22 From the shelf pop-up menu, select:

Firmware Upgrade -> this shelf

CAUTION
Loss of service
When upgrading the firmware on multiple line
cards, the cards are updated individually in a
sequential fashion. Data service is dropped only
on the line card currently being updated, for the
duration of the upgrade.

Note: Upgrading the firmware on an ATM core
card drops all data service on that shelf for the
duration of the upgrade.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

A Confirmation dialog appears.

23 Select OK.

A status window appears.

24 When “Upgrade completed” appears, click Close .

The status window disappears.

25 You are finished with this procedure.

—continued—
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E

e the UE9000 Data OAM&P User Guide).
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procedure.

ION
 service
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tial fashion. Data service is dropped only
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n of the upgrade.

Upgrading the firmware on an ATM core
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Procedure 2-10 (continued)
Upgrading the firmware

Step Action

Upgrading all the firmware on an N

26 Go to the NE submap (se

27 Repeat steps 15 through 1
MLC for each shelf in the 

28 From the NE pop-up men

Firmware Upgrade -> on 

A warning appears to tell

29 Click OK.

The warning disappears a

30 When “Upgrade complete

The status window disapp

31 You are finished with this 

—end—
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Procedure 2-11
Replacing an ATM core card

Use this procedure to replace an ATM core card.

Action

Step Action

CAUTION
Loss of communication
Replacing an ATM core card changes the media
access control (MAC) address of the ATM core
card. Data network devices, such as routers,
must be updated with the MAC address of the
new ATM core card. If the data network devices
are not updated, communication with the ATM
core card is lost. Inform your network
administrator of the new MAC address for the
ATM core card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Note: Voice service will not be affected.

1 Put the ATM core card out-of-service. Select:

Maintenance -> Atmif -> Lock -> Normal  (for DS1 ATM)

Maintenance -> Lock -> Normal  (for DS3 ATM)

The ATM core card is out-of-service (locked).

—continued—

CAUTION
Loss of service
If the UE9000 shelf is equipped with only one
ATM core card, replacing the card drops all data
service on the entire UE9000 shelf. If the shelf is
equipped with two DS3 ATM core cards, make
sure the card you are replacing is not the “active”
card.
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he front of the ATM core card to be

 card latches and pull the card outward.

rd into the slot and seat it into the UE9000
tly move tight-fitting cards from side to side

he top and bottom of the card.

sing the procedures described in the
up Guide.

 front of the new ATM core card.

 few seconds before resuming normal
uick Reference on the back cover of this

ER
injury or equipment damage
ous voltages may exist on the cables and
tors. Handle these cables with care.
Procedure 2-11 (continued)
Replacing an ATM core card

Step Action

2 Remove the cables from t
replaced.

3 Unlock the top and bottom

4 Carefully slide the new ca
backplane connector. Gen
while inserting.

5 Lock the card latches on t

6 Configure the ATM card u
UE9000 Data System Set

7 Connect the cables to the

The LEDs illuminate for a
operation. See the LED Q
guide.

—continued—

DANG
Risk of 
Hazard
connec
UE9000 DMS 297-8391-501 NA015
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Procedure 2-11 (continued)
Replacing an ATM core card

Step Action

Verify that the correct load is provisioned

8 Go to the shelf submap (see the UE9000 Data OAM&P User Guide)
and right click the ATM card symbol. Select Show -> Inventory ->
Atmif  from the pop-up menu.

The Atmif Inventory window appears.

9 Double-click UE9000 Map Application  in the Object Attributes field.

The Attributes for Objects dialog appears.

10 Does the provisioned load name match the current load name?

If Then

yes Go to step 11.

no Perform a restart reload on the ATM card. From the
pop-up menu, select:

Maintenance -> Atmif -> Restart -> Reload -> Normal
(for DS1 ATM)

Maintenance -> Restart -> Reload -> Normal (for
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Put the ATM card in service

11 Put the ATM core card in-service. Select:

Maintenance -> Atmif -> Unlock -> Normal  (for DS1 ATM)

Maintenance -> Unlock -> Normal  (for DS3 ATM)

The ATM core card is in-service.

Update recovery data

Note: This procedure is for a UE9000 shelf equipped with DS3 ATM
core card(s). Not supported for DS1 IMA core cards.

12 From the ATM card’s pop-up menu, select:

Maintenance ->Update Recovery Data ->No Reboot

A Confirmation dialog appears.

13 Select OK.

The configuration file is transferred to the ATM core card.
—end—

DS3 ATM)
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card

n xDSL multi-circuit line card (MLC).

e

t Status screen on the AccessNode,
y screen:

 xDSL MLC drops all voice and data
 xDSL MLC.

t more than five seconds to reinsert a line
oving the line card from the shelf to reseat
t wait more than five seconds, the line
all voice and data service for five to eight
Procedure 2-12
Replacing an xDSL multi-circuit line 

Use this procedure to replace a

Action

Step Action

Take all voice facilities out of servic

1 From the Network Elemen
display the required facilit

fa mlc [shelf #] [mlc #] ↵

CAUTION
Loss of service
Replacing an
service on the

CAUTION
Loss of service
You must wai
card after rem
it. If you do no
card can drop
minutes.

where

[shelf #] 1 to 7
UE9000 DMS 297-8391-501 NA015

The selected carrier screen appears.

Note: For more information about voice facilities, see the UE9000
Voice OAM&P User Guide.

—continued—

[mlc #] 1 to 16 (or 0 to 15 for UE9000 DMS)
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Procedure 2-12 (continued)
Replacing an xDSL multi-circuit line card

Step Action

2 Change the operating state of the facilities to OOS:

chgstate [state] [first circuit] [last circuit] ↵

If you change state from IS to OOS, the system prompts for
confirmation (yes  or no ). Confirm the change to OOS by entering
yes .

3 Press the OK button to confirm, or the Cancel  button to cancel the

where

[state] the operating state: is  or oos

[first circuit] the first line number in the desired range
from 1 to 4 (for ADSL) or 0 to 3 (for
UE9000 DMS)

The [first circuit] parameter must be less
than the [last circuit] parameter.

[last circuit] the last line number in the desired range
from 1 to 4 (for ADSL) or 0 to 3 (for
UE9000 DMS)
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

action.

The facility screen is updated with the new operating state.

Take all data facilities out of service

4 From the uEMS GUI Shelf submap (see the UE9000 Data OAM&P
User Guide), right click the xDSL MLC symbol. Select Maintenance
-> ADSL4  -> Lock -> Normal from the pop-up menu.

5 Press the OK button to confirm, or the Cancel  button to cancel the
action.

The xDSL MLC is out-of-service.

—continued—
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 the front of the card to be replaced.

 card latches and pull the card outward.

rd into the slot and seat it into the UE9000
tly move tight-fitting cards from side to side

he top and bottom of the card.

e front of the new card.

 few seconds before resuming normal
Reference on the back cover of this guide.

ioned

ee the UE9000 Data OAM&P User Guide)
d symbol. Select Show -> Inventory  from

indow appears.

 Application  in the Object Attributes field.

 dialog appears.

 name match the desired load name?

ER
injury or equipment damage
ous voltages may exist on the VF cables
nnectors. Handle these cables with care.
Procedure 2-12 (continued)
Replacing an xDSL multi-circuit line card

Step Action

Physically replace the card

6 Remove the cable(s) from

7 Unlock the top and bottom

8 Carefully slide the new ca
backplane connector. Gen
while inserting.

9 Lock the card latches on t

10 Connect the cable(s) to th

The LEDs illuminate for a
operation. See LED Quick

Verify that the correct load is provis

11 Go to the shelf submap (s
and right click the line car
the pop-up menu.

The Line Card Inventory w

12 Double-click UE9000 Map

The Attributes for Objects

13 Does the provisioned load

DANG
Risk of 
Hazard
and co
UE9000 DMS 297-8391-501 NA015

—continued—

If Then

yes Go to step 14.

no Perform a restart reload on the line card. Select
Maintenance -> [xDSL] -> Restart -> Reload ->
Normal from the pop-up menu.
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Procedure 2-12 (continued)
Replacing an xDSL multi-circuit line card

Step Action

Put all data facilities in service

14 From the uEMS workstation, put the xDSL MLC in-service. Select:

Maintenance -> [xDSL] -> Unlock -> Normal.

The xDSL MLC is in-service.

Update recovery data

Note: This procedure is for a UE9000 shelf equipped with DS3 ATM
core card(s). Not supported for DS1 IMA core cards.

15 From the ATM card’s pop-up menu (see Procedure 2-7, “Updating
Recovery Data” on page 2-17), select:

Maintenance ->Update Recovery Data ->No Reboot

A Confirmation dialog appears.

16 Select OK.

The configuration file is transferred to the ATM core card.

Put all voice facilities in service
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

17 From the Network Element Status screen on the AccessNode,
display the required facility screen:

fa mlc [shelf #] [mlc #] ↵

The selected facility screen appears.

—continued—

where

[shelf #] 1 to 7

[mlc #] 1 to 16 (or 0 to 15 for UE9000 DMS)
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te of the facilities to IS:

uit] [last circuit] ↵

ted with the new operating state.

 operating state: is  or oos

first line number in the desired range from
4 (for ADSL) or 0 to 3 for UE9000 DMS

[first circuit] parameter must be less than
 [last circuit] parameter.

last line number in the desired range from
4 (for ADSL) or 0 to 3 for UE9000 DMS
Procedure 2-12 (continued)
Replacing an xDSL multi-circuit line card

Step Action

18 Change the operating sta

chgstate [state] [first circ

The facility screen is upda

—end—

where

[state] the

[first circuit] the
1 to

The
the

[last circuit] the
1 to
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UE9000 D

Testing and performance monitoring 3-

This chapter describes how to perform routine tests on the Universal Edge
9000 (UE9000) system and monitor the performance of UE9000 facilities.

Chapter contents
This chapter contains the following topics:

• Performance monitoring on page 3-2

• Performing tests in uEMS on page 3-12

This chapter contains the following tasks.

Task Procedure
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Performing the ATM loopback upstream test Procedure 3-1 on page 3-13

Performing the ATM loopback downstream
test

Procedure 3-2 on page 3-15

Performing the inject bad HEC upstream test Procedure 3-3 on page 3-17

Performing the inject bad payload upstream
test

Procedure 3-4 on page 3-19

Performing the DMT utopia loopback
upstream test

Procedure 3-5 on page 3-21

Performing the one-shot loopback test Procedure 3-6 on page 3-23

—end—
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ed to poll SNMP MIB variables on the ATM
ed data on a table or a graph. Use the pop-up
ircuit (LC submap) and the DS1 carrier (DAC
, as described in the following sections.

les using the MIB browser feature of Hewlett
e MIB browser, selectMisc->SNMP MIB
rd OpenView documentation for information

s you to create customized graphs. To create
plication Builder:SNMP . See the HP

formation on how to use this tool. When
ID and issue this command:

uems/tools/convertGraphAppToUE900

tion
e MIB browser to change provisioning or
ion in uEMS. The MIB browser, which is
penView, can only be used to view MIB

 uEMS.
Performance monitoring
The uEMS GUI may be configur
core card and to plot the collect
menus of the xDSL subscriber c
submap) to initiate the process

You can also view these variab
Packard OpenView. To open th
Browser. See the Hewlett Packa
on how to use this tool.

Creating customized graphs
Hewlett Packard OpenView allow
a graph, selectOptions -> MIB Ap
OpenView documentation for in
finished, record the application 

/opt/OV/bin/Nortel/HSTP/
0.sh [application ID]

CAUTION
Database corrup
Do not use th
state informat
a part of HP O
information in
UE9000 DMS 297-8391-501 NA015
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Performance monitoring on ADSL data circuits
The ADSL subscriber circuit symbol pop-up menu provides the following
methods for tracking data.

f

Table 3-1
Performance monitor data for ADSL subscriber circuits

This command... displays these variables

Monitor -> ATM stats (access
side)

inTotal, outTotal, inDiscard

This table displays real-time data for the ATM card.

Monitor -> Rx/Tx Rates ChanCurrTxRate, CurrAttainableRate

Units = bits per second

This graph displays real-time data for the ATU-C and ATU-R.

Monitor -> Signal Strength CurrSnrMgn, CurrAtn

Units = dB

This graph displays real-time data for the ATU-C and ATU-R.

Monitor -> G.Lite Counters This graph displays data for the current 15-minute window for the
number of fast retrains and failed fast retrains for the link.

Monitor -> ADSL Errors CorrectedBlks, UncorrectedBlks
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

This graph displays data for the current 15-minute window for the
ATU-C and ATU-R.

Monitor -> Performance ->
ADSL Atuc

Lofs, Loss, Lols, Lprs, ESs, Inits

This graph displays data for the current 15-minute window for the
ATU-C.

Monitor -> Performance->
ADSL Atur

Lofs, Loss, Lprs, ESs

This graph displays data for the current 15-minute window for the
ATU-R.

Monitor -> Performance ->
ADSL Atuc Perfs

The Atuc Perfs graph displays the number of Atuc Lof, Los and Lol
faults that have been asserted since the ATM card was reset.

Monitor -> Performance ->
ADSL Atur Perfs

The Atur Perfs graph displays the number of Atur Lof, Los and Lpr
faults that have been asserted since the ATM card was reset.

—continued—
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scription of all the uEMS variables that can

cdI

 for the current 15-minute window for the

cdI

 for the current 15-minute window for the

ircuits

ce (in tenth dB) in the total power
 and the total power received by this ATU.

ween 0 and 60 dB. An example of trouble
hange over a short time period.

ccordance with ANSI T1.413.

nth dB) as seen by this ATU with respect

st 6 dB for full rate ADSL circuits, and at
n example of trouble indication would be

continued)
SeeTable 3-2 on page 3-4for a de
be graphed.

Monitor -> Performance ->
Enterprise Atuc

FecI, CrcI, HecI, Ocdl, L

This graph displays data
ATU-C.

Monitor -> Performance ->
Enterprise Atur

FecI, CrcI, HecI, Ocdl, L

This graph displays data
ATU-R.

—end—

Table 3-2
Performance monitoring variables for ADSL subscriber c

Variable Description

CurrAtn Line attenuation

This is the measured differen
transmitted by the peer ATU

This variable should vary bet
indication would be a large c

This value is determined in a

CurrSnrMgn Noise margin

This is the noise margin (in te
to its received signal.

This variable should be at lea
least 4dB for G.Lite circuits. A

Table 3-1
Performance monitor data for ADSL subscriber circuits (

This command... displays these variables
UE9000 DMS 297-8391-501 NA015

a noise margin of less than 6 dB or 4dB +/- 1dB for the various service
types. These values are determined in accordance with ANSI T1.413
and G.992.2. Possible causes for lower values may be noise on the
loop. Refer to the “Check the Subscriber Loop Performance” section in
Procedure 1-1, “” on page 1-21. This value is determined in accordance
with ANSI T1.413.

—continued—
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CurrOutputPwr Total output power

This is the total output power (in tenth dBm) from the modem as
measured during the last activation sequence.

This variable is higher for long subscriber loops and lower for short
subscriber loops. The power level is selected by the modems when they
establish the connection. An example of trouble indication would be a
value that is not constant over time.

CurrAttainableRate Maximum attainable rate

This is the maximum currently attainable data rate (in bits per second)
by the modem. This value is equal or greater than the ChanCurrTxRate.

This variable is set to the maximum value that could be attained if the
CurrSnrMgn were zero. An example of trouble indication would be if this
variable fell below the ChanCurrTxRate.

ChanCurrTxRate Current rate

This is the current rate of transmission (in bits per second) between the
ATU-R and the ATU-C.

The current rate is selected by the modems when they establish the

Table 3-2 (continued)
Performance monitoring variables for ADSL subscriber circuits

Variable Description
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

connection. This value remains constant during the link. A step change
indicates when the link is dropped and reconnected. An example of
trouble indication would be if the current rate increases or decreases
over time, or if it changes often.

ChanPrevTxRate Previous rate

This is the previous rate of transmission (in bits per second) between
the ATU-R and the ATU-C. (See ChanCurrTxRate for more
information).

ChanCrcBlockLength Channel data block length

This is the size of a channel’s data block that is subject to a CRC check.
This variable includes the number of redundant check bytes and the
number of message bytes over which the check bytes provide
protection.

This value is rate dependent.

—continued—



3-6   Testing and performance monitoring

y (in milliseconds) introduced by the

ccordance with ANSI T1.413.

unt of the number of Fast Retrains
onse to changing line conditions, in order
erformance parameters. Fast Retrains can
vents such as a phone going on/off hook,
mber or Fast Retrains can indicate a high
oor line quality.

unt of the number of Fast Retrains that
y the modems. A Fast Retrain failure may
 to select an appropriate line profile from
ds the provisioned performance
onditions. (A profile is a parameter lookup
nd is based on a history of previously
 A profile selection may fail because the
been encountered before; in this case the
w profile to use the next time this line
lection may also fail if a similar line
reviously but the profile was not saved
ll. An example of trouble would be if there
Fast Retrains in relation to the number of

ctive action is to manually clear the profile
ce -> Circuit -> G.Lite -> Clear Retrain

 framing (LOF) faults. For a description of
e “Line card and circuit faults” on

ircuits
ChanInterleaveDelay Interleave delay

This is the transmission dela
interleaving process.

This value is determined in a

FastRetrains For G.Lite circuits only. A co
attempted by modem in resp
to maintain the provisioned p
be initiated by common line e
dialling or ringing. A large nu
amount of phone activity or p

FailedFastRetrains For G.Lite circuits only. A co
failed, requiring a full retrain b
occur if the modem is unable
its table that meets or excee
parameters for the new line c
table stored by the modem a
encountered line conditions.)
new line condition has never
modem will try to create a ne
condition is seen. A profile se
condition was encountered p
because the profile table is fu
were a high number of Failed
Fast Retrains. Possible corre
table by selecting “Maintenan
Profiles.

Lofs Loss of frame *

This is the number of loss of
line card and circuit faults, se

Table 3-2 (continued)
Performance monitoring variables for ADSL subscriber c

Variable Description
UE9000 DMS 297-8391-501 NA015

page 4-28.

Loss Loss of signal *

This is the number of loss of signal (LOS) faults. For a description of line
card and circuit faults, see “Line card and circuit faults” on page 4-28.

—continued—
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Lols Loss of link *

This is the number of loss of link (LOL) faults. For a description of line
card and circuit faults, see “Line card and circuit faults” on page 4-28.

Lprs Loss of power *

This is the number of loss of power faults. For a description of line card
and circuit faults, see “Line card and circuit faults” on page 4-28.

ESs Errored seconds *

This is the number of one-second intervals containing one or more
cyclical redundancy check (CRC) anomalies or containing one or more
LOS or severely errored frame (SEF) defects.

Inits Line initialization *

This is the number of line initialization attempts. It includes both
successful and unsuccessful attempts.

CrcI Cyclical redundancy check *

This is the number of CRC anomalies which occur on the interleaved
data stream.

Table 3-2 (continued)
Performance monitoring variables for ADSL subscriber circuits

Variable Description
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

FecI Forward error correction *

This is the number of forward error correction (FEC) anomalies which
occur on the interleaved data stream.

HecI Header error check *

This is the number of header error check (HEC) anomalies which occur
on the interleaved data stream.

LcdI Loss of cell delineation *

This is the number of loss of cell delineation anomalies which occur on
the interleaved data stream.

ReceivedBlks Received blocks *

This is the number of encoded blocks received on this channel.

TransmittedBlks Transmitted blocks *

This is the number of encoded blocks transmitted on this channel.

—continued—
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ircuits
u provides the following graphs for tracking

received with errors that were corrected.
 as good data.

received with uncorrectable errors.

-minute window. These variables are
dication would be if the “15Min Threshold
red in the alarm browser, or if the values
e 4 of the UE9000 Data OAM&P User
e on the loop. Refer to the “Check the
1, “” on page 1-21.

1 circuits

lays these variables

1CurrentESs

1CurrentSESs

1CurrentUASs

1CurrentLCVs

LinkImaViolations

LinkNeSevErroredSec

ircuits
Performance monitoring on DS1 c
The Carrier symbol pop-up men
data:

f

CorrectedBlks Corrected blocks *

This is the number of blocks 
These blocks are passed on

UncorrectedBlks Uncorrected blocks *

This is the number of blocks 

* Note : These variables are counters for the current 15
available for ATU-C or ATU-R. An example of trouble in
Trap Exceeded” event for any of these counters appea
are approaching the defaults noted in Table 3-2 on pag
Guide for the thresholds. Possible causes may be nois
Subscriber Loop Performance” section in Procedure 1-

—end—

Table 3-3
Performance monitor graph for DS

This graph... disp

DS1 Carrier dsx

dsx

dsx

dsx

IMA Link ima

ima

Table 3-2 (continued)
Performance monitoring variables for ADSL subscriber c

Variable Description
UE9000 DMS 297-8391-501 NA015

These variables are described in the following table.

imaLinkFeSevErroredSec

imaLinkNeUnavailSec

imaLinkFeUnavailSec
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Table 3-4
Performance monitoring variables for DS1 circuits

Variable Description

dsx1CurrentESs This is the number of errored seconds
encountered by a DS1 interface in the current
15-minute interval.

dsx1CurrentSESs This is the number of severely errored
seconds encountered in the current
15-minute interval.

dsx1CurrentUASs This is the number of unavailable seconds
encountered by a DS1 interface in the current
15-minute interval.

dsx1CurrentLCVs This is the number of line code violations
(LCVs) encountered by a DS1 interface in the
current 15-minute interval.

—continued—

imaLinkImaViolations This is the number of errored, invalid or
missing ICP cells during a non-SES-IMA
condition.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

imaLinkNeSevErroredSec This is the number of one second intervals
containing either of the following:

• several IV-IMA defects

• one or more link defects (e.g., LOS,
OOF/LOF, AIS, LCD), LIF, LODS defects
during a non-UAS-IMA condition

imaLinkFeSevErroredSec This is the number of one second intervals
containing one or more RDI-IMA defects.
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ircuits
u provides the following graphs for tracking

is the number of unavailable seconds at
r-end.

vailability begins at the onset of 10
tiguous SES-IMA defects. Unavailability
s at the onset of 10 contiguous seconds
 no SES-IMA defects.

is the number of unavailable seconds at
end:

vailability begins at the onset of 10
tiguous SES-IMA-FE defects.
vailability ends at the onset of 10
tiguous seconds with no SES-IMA-FE
cts.

—end—

3 circuits

ariables

Ss

Vs

Ss

for DS1 circuits

cription
Performance monitoring on DS3 c
The Carrier symbol pop-up men
data:

f

imaLinkNeUnavailSec This
nea

Una
con
end
with

imaLinkFeUnavailSec This
far-

Una
con
Una
con
defe

Table 3-5
Performance monitor graph for DS

This graph....  displays these v

DS3 Carrier dsx3CurrentLES

dsx3CurrentUA

dsx3IntervalCC

dsx3IntervalCE

Table 3-4 (continued)
Performance monitoring variables 

Variable Des
UE9000 DMS 297-8391-501 NA015

These variables are described in the following table.
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Table 3-6
Performance monitoring variables for DS3 circuits

Variable Description

dsx3CurrentLESs The number of line errored seconds
encountered by a DS3/E3 interface in the
current 15-minute interval.

dsx3CurrentUASs The counter associated with the number of
unavailable seconds encountered by a DS3
interface in the current 15-minute interval.

dsx3IntervalCCvs The number of C-bit coding violations
encountered by a DS3 interface in one of the
previous 96 individual 15-minute intervals.

dsx3IntervalCESs The number of C-bit errored seconds
encountered by a DS3 interface in one of the
previous 96 individual 15-minute intervals.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01



3-12   Testing and performance monitoring

ormance monitoring graph.

UE-1041

faulty equipment. The UE9000 system
e data being sent, but some areas of the
itored by these checks. Loopbacks allow you

UE 1041
Sample Graph
Figure 3-1 shows a sample perf

Figure 3-1
Sample performance monitoring graph

Performing tests in uEMS
Data loopbacks aid in isolating 
performs automatic checks of th
UE9000 equipment are not mon
UE9000 DMS 297-8391-501 NA015

to check areas of the equipment that are not automatically monitored.

There are two types of data loopbacks: in-service (IS) and out-of-service
(OOS). IS loopbacks are used while the UE9000 equipment is passing traffic
and do not affect data service. OOS loopbacks are used when the UE9000
equipment is not passing traffic and affect data service.
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Procedure 3-1
Performing the ATM loopback upstream test

This test loops ATM cells back toward the carrier network interface at the
backplane interface to the line card. During the test, all of the line card
circuitry is isolated. You can use this test to verify the ability of the ATM card
and the backplane to properly handle ATM cells.

Figure 3-2
ATM loopback upstream test

UE-1077

DS1 IMA or
DS3 interface

ATMIF Core card LC

DFE AFE

 xDSL loops

ALL Modems 
looped back

UE-1077
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

This test:

• is service affecting for all line circuits on the line card

• runs continuously until manually stopped

• can be run while the line card is either locked or unlocked

• cannot be run at the same time as the ATM loopback downstream test

—continued—



3-14   Testing and performance monitoring

pen the line card pop-up menu and select

pback -> ATMLoopbackUpstream ->

op back all ATM cells in the upstream

pback -> ATMLoopbackUpstream ->

e card, select

pback -> Stop all tests and loopback
Procedure 3-1 (continued)
Performing the ATM loopback upstream test

Action

Step Action

1 From the shelf submap, o

Maintenance -> LC -> Loo
Start

The line card begins to lo
direction.

2 To stop the test, select:

Maintenance -> LC -> Loo
Stop

3 To stop all tests on this lin

Maintenance -> LC -> Loo

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 3-2
Performing the ATM loopback downstream test

This test loops ATM cells through the line card back toward the customer
premises equipment (CPE). During the test, the ATM card and the backplane
circuitry are isolated. You can use this test to verify the CPE, subscriber line,
and most of the modem circuitry.

Figure 3-3
ATM loopback downstream test

UE-1076

DS1 IMA or
DS3 interface

ATMIF Core card LC

DFE AFE

xDSL loops

ALL Modems 
looped back

UE-1076
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

This test:

• is service affecting for all line circuits on the line card

• runs continuously until manually stopped

• can be run only while the line card is locked

• cannot be run at the same time as the ATM loopback upstream test

Action

Step Action

1 From the shelf submap, open the line card pop-up menu and select

Maintenance -> ADSL4 -> Lock -> Normal

The line card is OOS (the symbol is tan and the annotation text is “L”)

—continued—
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pen the line card pop-up menu and select

 Loopback ->
 -> Start

op back all ATM cells in the downstream

 Loopback -> Stop all tests and

e card, select

 Loopback -> Stop all tests and

ges color when the equipment is
0 Data OAM&P User Guide for more
dicators in uEMS.
Procedure 3-2 (continued)
Performing the ATM loopback downstream test

Step Action

2 From the shelf submap, o

Maintenance -> ADSL4 ->
ATMLoopbackDownstream

The line card begins to lo
direction.

3 To stop the test, select:

Maintenance -> ADSL4 ->
loopbacks

4 To stop all tests on this lin

Maintenance -> ADSL4 ->
loopback

The line card symbol chan
in-service. See the UE900
information about visual in

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 3-3
Performing the inject bad HEC upstream test

This test injects cells with bad HEC bytes upstream from the line card toward
the ATM card. You can use this test to verify the error detection circuitry on
the ATM card.

Figure 3-4
Inject bad HEC upstream test

UE-1079

ATM
test set

ATMIF Core card LC

DFE AFE

xDSL 
loops

All modems
looped backATM cells with

DS1 IMA
or DS3
interface

Standard
ATM interface

ATM
edge switch

UE-1079
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This test:

• is service affecting for all line circuits on the line card

• runs continuously until manually stopped

• can be run while the line card is either locked or unlocked

• can be run at the same time as the ATM loopback upstream test

—continued—

bad HEC injected at
backplane interface
toward ATMIF card
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pen the line card pop-up menu and select

t -> InjectBadHECUpstream -> Start

nd cells with bad HEC bytes in the

t -> InjectBadHECUpstream -> Stop

e card, select

t -> Stop all tests and loopback
Procedure 3-3 (continued)
Performing the inject bad HEC upstream test

Action

Step Action

1 From the shelf submap, o

Maintenance -> LC -> Tes

The line card begins to se
upstream direction.

2 To stop the test, select:

Maintenance -> LC -> Tes

3 To stop all tests on this lin

Maintenance -> LC -> Tes

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 3-4
Performing the inject bad payload upstream test

This test injects cells with bad ATM cell payload bytes upstream from the line
card. You can use this test to verify the error detection circuitry on the ATM
card.

Figure 3-5
Inject bad payload upstream test
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This test:

• is service affecting for all line circuits on the line card

• runs continuously until manually stopped

• can be run while the line card is either locked or unlocked

• can be run at the same time as the ATM loopback upstream test and the
inject bad HEC upstream test

—continued—

toward ATMIF card
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pen the line card pop-up menu and select

t -> InjectBadPayloadUpstream -> Start

nd cells with bad ATM cell payload bytes in

t -> InjectBadPayloadUpstream -> Stop

e card, select

t -> Stop all tests and loopback
Procedure 3-4 (continued)
Performing the inject bad payload upstream test

Action

Step Action

1 From the shelf submap, o

Maintenance -> LC -> Tes

The line card begins to se
the upstream direction.

2 To stop the test, select

Maintenance -> LC -> Tes

3 To stop all tests on this lin

Maintenance -> LC -> Tes

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 3-5
Performing the DMT utopia loopback upstream test

This test loops ATM cells back toward the carrier network interface at the
ATM cell interface to the line card modems. You can use this test to verify the
line card ATM cell mux/demux and a portion of the modem digital front end.
This test also verifies the integrity of the ATM card and the backplane.

Figure 3-6
DMT utopia loopback upstream test
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• is service affecting for all line circuits on the line card

• runs continuously until manually stopped

• can be run only while the circuit is locked

• cannot be run at the same time as any other test

Action

Step Action

1 From the LC submap, open the circuit pop-up menu and select

Maintenance -> Circuit -> Lock -> Normal

The circuit is OOS (the symbol is tan and the annotation text is “L”)

—continued—
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t

n the circuit pop-up menu and select

 Loopback -> DMT UTOPIA Loopback

 Loopback -> DMT UTOPIA Loopback

n the circuit pop-up menu and select

 Unlock -> Normal

anges color when the equipment is
0 Data OAM&P User Guide for more
dicators in uEMS.
Procedure 3-5 (continued)
Performing the DMT utopia loopback upstream tes

Step Action

2 From the LC submap, ope

Maintenance -> Circuit ->
Upstream -> Start

The test begins.

3 To stop the test, select:

Maintenance -> Circuit ->
Upstream -> Stop

4 From the LC submap, ope

Maintenance -> Circuit ->

The line circuit symbol ch
in-service. See the UE900
information about visual in

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 3-6
Performing the one-shot loopback test

This test sends an ATM cell either to the next segment end-point (normally
the edge switch) or to the final destination node. For the test to be considered
successful, the cell must return within 5 seconds.

This test:

• can be received by or originated from the UE9000 shelf

• runs once (not continuously)

Figure 3-7
Access side loopback
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—continued—
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UE-1051

n the circuit pop-up menu and select

est: one shot loopback
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onnect is tested.
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s whether the test is for the segment or the

e field, enter Access  or Network . This
ether the test is for the subscriber loop
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Procedure 3-6 (continued)
Performing the one-shot loopback test

Figure 3-8
Network side loopback

Action

Step Action

1 From the LC submap, ope

Maintenance -> VCC -> T
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2 In the VCC number field, 
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The test begins. The test results indicate either pass or fail.

—end—
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UE9000 D

uEMS faults and events 4-

The procedures in this chapter describe how to clear UE9000 element
management system (uEMS) alarms/faults and events.

The events and faults are grouped alphabetically by the event/fault text. Each
procedure describes the cause of the event/fault and the action needed to clear
it.

Note 1: For information on viewing events and interpreting the
information in the Events Browser window, see theUE9000 Data
OAM&P User Guide.

Note 2: For information on viewing alarms and interpreting the
information in the Alarm Browser window, see theUE9000 Data

Chapter con
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

OAM&P User Guide.

tents
This chapter contains the following topics:

• Faults and events in uEMS on page 4-2

• uEMS events on page 4-7

• Threshold events on page 4-23

• Line card and circuit faults on page 4-28

This chapter includes the following tasks:

Task Procedure

Viewing events Procedure 4-1 on page 4-3

Viewing help for a uEMS event Procedure 4-2 on page 4-5

Deleting events Procedure 4-3 on page 4-6
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 faults to indicate the following conditions:
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starting
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Data OAM&P User Guidefor information
ies window.

ent category in the Event Categories window
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ide for an explanation of each color.
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Procedure 4-1
Viewing events

Use this procedure to view events on the UE9000 element management
system (uEMS). See theUE9000 Data OAM&P User Guidefor a description
of the Event Browser.

Interpreting the information in the Event Browser window
For a description of the fields displayed in the Event Browser window, see the
Hewlett Packard OpenView documentation.

The following is an example of an event in the Event Browser window:

Ack Severity Date/Time Source Message
Normal Tue July 14 16:59:07 NE.01/SHELF.UE1/DAC.A Dac Status
Changed::New st

Event severity
For an explanation of event severity, see theUE9000 Data OAM&P User
Guide.

Action
Step Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Viewing events from the Event Categories window

1 In the Event Categories window, click the button to the left of the
Nortel uEMS Events category.

The Event Browser window appears with a list of the events for that
category.

2 In the Event Browser window, double-click the event you want to see.

The submap where the event occurred appears. The UE9000
component that is the source of the event is highlighted in the
submap.

—continued—



4-4   uEMS faults and events

p, highlight the UE9000 component’s
ee events for.

menu, select Events .

w displays a listing of all the events for the
ent.
Procedure 4-1 (continued)
Viewing events

Step Action

Viewing events from a submap

3 In the appropriate subma
symbol that you want to s

4 From the Fault pull-down 

The Event Browser windo
selected UE9000 compon

—end—
UE9000 DMS 297-8391-501 NA015
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Procedure 4-2
Viewing help for a uEMS event

Use this procedure to view detailed information about events.

Note: Some events require no action. Those events are not included in
this book.

Action

Step Action

1 In the Event Browser window, highlight the event for which you want
more information.

2 From the View pull-down menu, select Describe Event .

The Describe Event dialog appears. The cause of the event is
displayed in the Event Description field.

3 When you are finished using the Describe Event dialog, press the
Close  button.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 until one of the following actions occurs:

eted

ht the event in the Event Browser window
cted Events from the Actions pull-down
Procedure 4-3
Deleting events

The uEMS GUI saves all events

• the hard disk becomes full

• one or more events are del

Action

Step Action

1 To delete an event, highlig
and select Delete -> Sele
menu.

—end—
UE9000 DMS 297-8391-501 NA015
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uEMS events
Table 4-1 lists each event and a cause and solution for each.

Table 4-1
uEMS events

Event Solution

Carrier Config Failed

Severity: Critical

Cause: The uEMS has
failed an attempt to send
provisioning data to the
DS1 or DS3 carrier.

• Check and verify that the information that was provisioned is
correct and consistent.

• Select Misc->Nortel uEMS->Carrier Force Synchronize from
the uEMS GUI to force the uEMS to retry pushing the shelf
information to the shelf.

• If the above fails, perform the following commands from the
prompt (you need root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"
is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• If the problem persists, contact Technical Support and provide
them with the following information:
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

- The output generated from the command
/opt/OV/bin/ovobjprint .

- The file /var/opt/OV/share/log/trapd.log.

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

Carrier Fault Occurred

Severity: Depends on the
nature of the fault

Cause: A fault has
occurred on a DS1 carrier.

• Resolve the problem with the carrier. See Chapter 1,
“Troubleshooting,” for troubleshooting information.

—continued—
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 with the carrier and then retest. See
hooting,” for troubleshooting information.

hreshold has been exceeded.

 the threshold value to a different value.
a OAM&P User Guide for information on
mand line user interface (CLUI).

t the information that was provisioned is
t.

EMS->Cct Force Synchronize from the
e uEMS to retry pushing the shelf

elf.

form the following commands from the
t-access privilege to do this):

 ovstatus and ensure that for all, "state:"

tus

UNNING, then perform the following:
p
rt

ts, contact Technical Support and provide
g information:

ted from the command
rint .

/share/log/trapd.log.
Carrier Test Complete Failed

Severity: Critical

Cause: A test attempt has
failed on the DS1 carrier.

• Resolve the problem
Chapter 1, “Troubles

Carrier Threshold Exceeded

Severity: Major

Cause: A threshold is
exceeded on a DS1
carrier.

• Investigate why this t

• If desired, reprovision
See the UE9000 Dat
using the uEMS com

Cct Config Failed

Severity: Critical

Cause: The uEMS has
failed an attempt to send
provisioning data to an
xDSL circuit.

• Check and verify tha
correct and consisten

• Select Misc->Nortel u
uEMS GUI to force th
information to the sh

• If the above fails, per
prompt (you need roo

- Inspect output from
is "RUNNING".
> /opt/OV/bin/ovsta

- If hstpmon is not R
> /opt/OV/bin/ovsto
> /opt/OV/bin/ovsta

• If the problem persis
them with the followin

- The output genera
/opt/OV/bin/ovobjp

- The file /var/opt/OV

Table 4-1 (continued)
uEMS events

Event Solution
UE9000 DMS 297-8391-501 NA015

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

—continued—
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Cct Fault Occurred

Severity: Depends on the
nature of the fault

Cause: A fault has
occurred on an xDSL
subscriber circuit.

• See “Line card and circuit faults” on page 4-28.

Cct Test Complete Failed

Severity: Critical

Cause: A test attempt has
failed on an xDSL circuit.

• Resolve the problem with the circuit and then retest. See
Chapter 1, “Troubleshooting,” for troubleshooting information.

Cct Threshold Exceeded

Severity: Major

Cause: A threshold is ex-
ceeded on an xDSL circuit.

• Investigate why this threshold has been exceeded.

• If desired, reprovision the threshold value to a different value.
See the UE9000 Data OAM&P User Guide for information on
using the uEMS command line user interface (CLUI).

—continued—

Table 4-1 (continued)
uEMS events

Event Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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t the information that was provisioned is
t.

EMS->DAC Force Synchronize  from
e the uEMS to retry pushing the shelf

elf.

form the following commands from the
t-access privilege to do this):

 ovstatus and ensure that for all, "state:"

tus

UNNING, then perform the following:
p
rt

ts, contact Technical Support and provide
g information:

ted from the command
rint .

/share/log/trapd.log.

/share/log/Nortel/HSTP/hstpmon

yslog/syslog.log.

elp->Nortel uEMS->About uEMS .

software running on the cards in the shelf.

oper software load and update the load on
M core card.
Dac Config Failed

Severity: Critical

Cause: The uEMS has
failed an attempt to send
provisioning data to the
ATM card.

• Check and verify tha
correct and consisten

• Select Misc->Nortel u
the uEMS GUI to forc
information to the sh

• If the above fails, per
prompt (you need roo

- Inspect output from
is "RUNNING".
> /opt/OV/bin/ovsta

- If hstpmon is not R
> /opt/OV/bin/ovsto
> /opt/OV/bin/ovsta

• If the problem persis
them with the followin

- The output genera
/opt/OV/bin/ovobjp

- The file /var/opt/OV

- The file /var/opt/OV
-<username>.log.

- The file /var/adm/s

- The output from H

- The version of the

Dac Diff. Active/stby Current
Loads

Severity: Minor

Cause: The DAC A and

• Check which is the pr
the incorrect DS3 AT

Table 4-1 (continued)
uEMS events

Event Solution
UE9000 DMS 297-8391-501 NA015

DAC B DS3 ATM card
software loads do not
match

—continued—
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Dac Diff. Prov. & Current
Loads

Severity: Minor

Cause: The provisioned
Atmif software loads does
not match the current Atmif
load.

• Upgrade the ATM card’s provisioned load. See Procedure 2-10,
“Upgrading the firmware” on page 2-23.

Dac Down

Severity: Major

Cause: Communication is
interrupted between the
uEMS and the ATM card

• Verify that the Data-Access-Card is not undergoing a restart.

• Select Fault->Nortel uEMS->verifyComm  to determine if the
Data-Access-Card is responding to SNMP messages from the
uEMS.

• Select Fault->Ping  to determine if the Data-Access-Card is
responding to IP messages from the uEMS. If it is not
responding, perform a ping between various nodes in the
network. To determine which portion of the path is faulty, ping
nodes which are along the uEMS to DAC communications path.

Dac Events Lost

Severity: Warning

The DAC buffers every event that it generates. When the uEMS
receives and acknowledges an event, the DAC removes that

Table 4-1 (continued)
uEMS events

Event Solution
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Cause: The ATM card has
lost events due to buffer
overflow.

The uEMS attempts to
recreate lost events.

event from its buffers.

If the uEMS does not acknowledge these events quickly enough,
the DAC buffers may overflow and these and all subsequent
events are lost.

This condition is likely to occur when communications between
the uEMS and DAC is down or the rate of generated events is very
high.

Even though this event is generated, the uEMS attempts to
re-create events that were lost. If, for instance, a line card had
changed state more than once, then the uEMS only re-creates the
event for the last state change.

—continued—
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 with the ATM card. See Chapter 1,
 troubleshooting information.

t the information that was provisioned is
t.

ated if the uEMS has lost communications
rd for at least a specific length of time. This
rable via HP OpenView.

urrence is when a Data-Access-Card is
Dac Fault Occurred

Severity: Depends on the
nature of the fault

Cause: A fault has
occurred on an ATM card

• Resolve the problem
“Troubleshooting,” for

Dac Hardware Mismatch

Severity: Major

Cause: The ATM card type
does not match what is
provisioned on the uEMS

• Check and verify tha
correct and consisten

Dac Hardware Removed

Severity: Warning

Cause: The ATM card is
removed.

This event is only gener
with a Data-Access-Ca
length of time is configu

The most common occ
removed.

—continued—

Table 4-1 (continued)
uEMS events

Event Solution
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Dac Restart Complete Failed

Severity: Critical

Cause: A restart attempt
has failed on an ATM card.

• Check and verify that the load name that was provisioned is
correct.

• Select Misc->Nortel uEMS->DAC Force Synchronize  from
the uEMS GUI to force the uEMS to retry pushing the shelf
information to the shelf.

• If the above fails, perform the following command from the
prompt (you need root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"
is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• Re-issue the restart operation. Consider doing a hardware
reset.

• If the problem persists, contact Technical Support and provide
them with the following information:

- The output generated from the command

Table 4-1 (continued)
uEMS events

Event Solution
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/opt/OV/bin/ovobjprint .

- The file /var/opt/OV/share/log/trapd.log.

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

Dac Test Complete Failed

Severity: Critical

Cause: A test attempt has
failed on an ATM card.

• Resolve the problem with the ATM card and then retest. See
Chapter 1, “Troubleshooting,” for troubleshooting information.

—continued—
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hreshold has been exceeded.

 the threshold value to a different value.
a OAM&P User Guide for information on
mand line user interface (CLUI).

ur if a DAC is unprovisioned on the uEMS
oved. In particular, this would occur if
en the uEMS and DAC was down at the
 operation.
Dac Threshold Exceeded

Severity: Major

Cause: A threshold is
exceeded on an ATM card.

• Investigate why this t

• If desired, reprovision
See the UE9000 Dat
using the uEMS com

Dac Unknown but Received

Severity: Warning

Cause: The uEMS has
received an event from an
ATM card that is not
provisioned on the uEMS.

This condition may occ
but the DAC is not rem
communications betwe
time of the unprovision

—continued—

Table 4-1 (continued)
uEMS events
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Db Error

Severity: Major

Cause: The uEMS has
detected an error in the
uEMS database.

This event is generated by the uEMS to provide error messages
about the uEMS database.

This event indicates that the uEMS database may be corrupted or
is in an unexpected state.

• Perform the following command from the prompt (you need
root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"
is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• Perform the following command to view the uEMS database
information for the given object to see if there is any obvious
corruption:

- > /opt/OV/bin/ovobjprint -s [Selection Name]

• If possible, unprovision and then re-provision the given object.

• If the database is corrupted, consider restoring the uEMS

Table 4-1 (continued)
uEMS events

Event Solution
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database. The database is in this directory:
/var/opt/OV/share/databases/openview/ovwdb/current

- See the UE9000 Data OAM&P User Guide for information
about backing up and restoring databases.

• If the problem persists, contact Technical Support and provide
them with the following information:

- The output generated from the command
/opt/OV/bin/ovobjprint .

- The file /var/opt/OV/share/log/trapd.log.

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

—continued—
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 command from the prompt (you need
 to do this):

 ovstatus and ensure that for all, "state:"
articular, ensure that "ovwdb" has no error

d against it.
tus

UNNING, then perform the following:
p
rt

ts, contact Technical Support and provide
g information:

ted from the command
rint .

/share/log/trapd.log.

/share/log/Nortel/HSTP/hstpmon

yslog/syslog.log.

elp->Nortel uEMS->About uEMS .

software running on the cards in the shelf.

 by the uEMS to provide warning
MS database.

MS database conditions that indicate a
oblem.

 message to avoid potential problems.
Db Timeout

Severity: Major

Cause: The uEMS
database subsystem is not
responding.

• Perform the following
root-access privilege

- Inspect output from
is "RUNNING". In p
messages reporte
> /opt/OV/bin/ovsta

- If hstpmon is not R
> /opt/OV/bin/ovsto
> /opt/OV/bin/ovsta

• If the problem persis
them with the followin

- The output genera
/opt/OV/bin/ovobjp

- The file /var/opt/OV

- The file /var/opt/OV
-<username>.log.

- The file /var/adm/s

- The output from H

- The version of the

Db Warning

Severity: Warning

Cause: The uEMS has
detected a condition that
could lead to a database
error.

This event is generated
messages about the uE

This event highlights uE
possible or potential pr

• Observe the warning

—continued—

Table 4-1 (continued)
uEMS events
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Lc Config Failed

Severity: Critical

Cause: The uEMS has
failed an attempt to send
provisioning data to an
xDSL MLC.

• Check and verify that the information that was provisioned is
correct and consistent.

• Select Misc->Nortel uEMS->Lc Force Synchronize  from the
uEMS GUI to force the uEMS to retry pushing the shelf
information to the shelf.

• If the above fails, perform the following command from the
prompt (you need root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"
is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• If the problem persists, contact Technical Support and provide
them with the following information:

- The output generated from the command
/opt/OV/bin/ovobjprint .

- The file /var/opt/OV/share/log/trapd.log.

Table 4-1 (continued)
uEMS events

Event Solution
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- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

Lc Fault Occurred

Severity: Depends on the
nature of the fault

Cause: A fault has
occurred on an xDSL MLC.

• See “Line card and circuit faults” on page 4-28.

—continued—
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 when the type of a line card does not
ed on the uEMS.

t the information that was provisioned is
t.

 when a line card is removed.

.

t the load name that was provisioned is
t.

 command from the prompt (you need
 to do this):

 ovstatus and ensure that for all, "state:"

tus

UNNING, then perform the following:
p
rt

peration. Consider doing a hardware reset.

ts, contact Technical Support and provide
g information:

ted from the command
rint .

/share/log/trapd.log.

/share/log/Nortel/HSTP/hstpmon
Lc Hardware Mismatch

Severity: Critical

Cause: The xDSL card
type does not match what
is provisioned on uEMS.

This event is generated
match what is provision

• Check and verify tha
correct and consisten

Lc Hardware Removed

Severity: Minor

Cause: The xDSL card is
removed.

This event is generated

• Replace the line card

Lc Restart Complete Failed • Check and verify tha
correct and consisten

• Perform the following
root-access privilege

- Inspect output from
is "RUNNING".
> /opt/OV/bin/ovsta

- If hstpmon is not R
> /opt/OV/bin/ovsto
> /opt/OV/bin/ovsta

• Reissue the restart o

• If the problem persis
them with the followin

- The output genera
/opt/OV/bin/ovobjp

- The file /var/opt/OV

- The file /var/opt/OV
-<username>.log.

Table 4-1 (continued)
uEMS events

Event Solution
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- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

Lc Test Complete Failed • Resolve the problem with the line card and then retest. See
Chapter 1, “Troubleshooting,” for troubleshooting information.

—continued—
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NE Fault Occurred • Resolve the problem with the NE. See Chapter 1,
“Troubleshooting,” for troubleshooting information.

Also refer to the UE9000 Voice OAM&P User Guide.

NV Store Config Failed • Send Update Recovery Data with Reboot. See Procedure 2-7,
“Updating Recovery Data” on page 2-17.

NV Store Download Failed • Retry Update Recovery Data (see Procedure 2-7, “Updating
Recovery Data” on page 2-17)

• Check to make sure the file size is less than 750 kB (file located
in /etc/opt/OV/share/conf/Nortel/HSTP/uems/nvstore )

Shelf Config Failed • Check and verify that the information that was provisioned is
correct and consistent.

• Select Misc->Nortel uEMS->Shelf Force Synchronize  from
the uEMS GUI to force the uEMS to retry pushing the shelf
information to the shelf.

• If the above fails, perform the following command from the
prompt (you need root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"

Table 4-1 (continued)
uEMS events

Event Solution
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is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• If the problem persists, contact Technical Support and provide
them with the following information:

- The output generated from the command
/opt/OV/bin/ovobjprint .

- The file /var/opt/OV/share/log/trapd.log.

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

—continued—
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 with the shelf. See Chapter 1,
 troubleshooting information.

t the load name that was provisioned is

 command from the prompt (you need
 to do this):

 ovstatus and ensure that for all, "state:"

tus

UNNING, then perform the following:
p
rt

operation. Consider doing a hardware

ts, contact Technical Support and provide
g information:

ted from the command
rint .

/share/log/trapd.log.

/share/log/Nortel/HSTP/hstpmon

yslog/syslog.log.

elp->Nortel uEMS->About uEMS .

software running on the cards in the shelf.
Shelf Fault Occurred • Resolve the problem
“Troubleshooting,” for

Shelf Restart Complete Failed • Check and verify tha
correct.

• Perform the following
root-access privilege

- Inspect output from
is "RUNNING".
> /opt/OV/bin/ovsta

- If hstpmon is not R
> /opt/OV/bin/ovsto
> /opt/OV/bin/ovsta

• Re-issue the restart 
reset.

• If the problem persis
them with the followin

- The output genera
/opt/OV/bin/ovobjp

- The file /var/opt/OV

- The file /var/opt/OV
-<username>.log.

- The file /var/adm/s

- The output from H

- The version of the

—continued—

Table 4-1 (continued)
uEMS events
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SNMP Error • Perform the following command from the prompt (you need
root-access privilege to do this):

- Inspect output from ovstatus and ensure that for all, "state:"
is "RUNNING".
> /opt/OV/bin/ovstatus

- If hstpmon is not RUNNING, then perform the following:
> /opt/OV/bin/ovstop
> /opt/OV/bin/ovstart

• Perform the following command and verify that SNMP is
configured appropriately:

- > /opt/OV/bin/xnmsnmpconf

• If the problem persists, contact Technical Support and provide
them with the following information:

- The output generated from the command
/opt/OV/bin/ovobjprint

- The file /var/opt/OV/share/log/trapd.log.

- The file /var/opt/OV/share/log/Nortel/HSTP/hstpmon
-<username>.log.

Table 4-1 (continued)
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- The file /var/adm/syslog/syslog.log.

- The output from Help->Nortel uEMS->About uEMS .

- The version of the software running on the cards in the shelf.

- The output from the command
/opt/OV/bin/xnmsnmpconf -dumpCache

—continued—
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cause of one of the following reasons:

configured too small.

alue may be increased by selecting
Configuration

 the uEMS and the DAC was down.

 if the uEMS has IP-connectivity to the
ault -> Ping .

ty string configured on the DAC is different
on the uEMS. When this event occurs, the
ve received an SNMP_Authen_Failure

ct your next level of support.

NMP protocol conditions that indicate a
oblem.

 with SNMP communications. See
hooting,” for troubleshooting information.

 DS3 ATM card is up and running

 DS3 ATM card is in the correct state

 DS3 ATM card is unlocked

arrier link is working

ent is to generate a message that the disk
 severity for this event varies depending

olds:

ce is between 80% and 89% full

ce is between 90% and 94% full

ace is between 95% and 97% full
SNMP Timeout A time-out is caused be

• The timeout value is 

- User Action: This v
Options -> SNMP 

• The network between

- User Action: Verify
DAC by selecting F

• The SNMP communi
from that configured
uEMS should also ha
event from the DAC.

- User Action: Conta

SNMP Warning This event highlights S
possible or potential pr

• Resolve the problem
Chapter 1, “Troubles

SWACT failure • Make sure “standby”

• Make sure “standby”

• Make sure “standby”

• Make sure the DS3 c

/var partition n% full The purpose for this ev
space is nearly full. The
on the following thresh

Minor event = disk spa

Major event = disk spa

Critical event = disk sp

Table 4-1 (continued)
uEMS events

Event Solution
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Note: In this case, a warning appears, indicating that log files will
be deleted when disk space becomes 98% full.

Critical event = disk space is between 98% and 100% full

Note: In this case, a warning appears, indicating that log files will
be deleted to avoid possible database corruption.

—end—
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Threshold events
Table 4-2 lists the circuit threshold types. The UE9000 equipment generates
threshold events when certain parameters exceed the configured threshold
value.

Table 4-2
Circuit threshold types

Type Description

atucfeci forward error correction anomalies on the interleaved
channel counted by the near-end modem

atuccrci cyclical redundancy check (CRC) anomalies on the
interleaved channel counted by the near-end modem

atucheci header error check failures on the interleaved channel
counted by the near-end modem

atuclcdi loss of cell delineation failures on the interleaved
channel counted by the near-end modem

aturfeci forward error correction anomalies on the interleaved
channel counted by the far-end modem

aturheci header error check failures on the interleaved channel
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

counted by the far-end modem

aturlcdi loss of cell delineation failures on the interleaved
channel counted by the far-end modem

aturblockErrori CRC anomalies on the interleaved channel detected at
the far-end equipment and reported back to the near-end
equipment

adslAtucThresh15
MinFailedFastR

This threshold crossing is sent when the number of failed
fast retrains is exceeded for the current 15-minute
window

adslAtucThresh15
MinLofs

near-end loss of frame defects for the current 15-minute
window

adslAtucThresh15
MinLoss

near-end loss of signal defects for the current 15-minute
window

—continued—
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reshold types. The UE9000 equipment
n certain parameters exceed the configured

 of link defects for the current 15-minute

of power defects for the current 15-minute

red seconds for the current 15-minute

ccessful line initialization attempts

f frame defects for the current 15-minute

f signal defects for the current 15-minute

f link defects for the current 15-minute

f power defects for the current 15-minute

—end—
Table 4-3 lists the DS1 carrier th
generates threshold events whe
threshold value.

adslAtucThresh15
MinLols

near-end loss
window

adslAtucThresh15
MinLprs

near-end loss
window

adslAtucThresh15
MinESs

near-end erro
window

adslAtucInitFailur
eTrapEnable

near-end unsu

adslAturThresh15
MinLofs

far-end loss o
window

adslAturThresh15
MinLoss

far-end loss o
window

adslAturThresh15
MinLols

far-end loss o
window

adslAturThresh15
MinLprs

far-end loss o
window

Table 4-3
DS1 carrier threshold types

Type Description

Table 4-2 (continued)
Circuit threshold types

Type Description
UE9000 DMS 297-8391-501 NA015

pvc path coding violations

es error seconds

ses severely errored seconds

sefs severely errored framing seconds

—continued—
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uas unavailable seconds

pcvFe path coding violations - far end

esFe error seconds - far end

sesFe severely errored seconds - far end

sefsFe severely errored framing seconds - far end

uasFe unavailable seconds - far end

lcv line code violations

les line errored seconds

lesFe line errored seconds - far end

fcGrp failure count - IMA group

fcGrpFe failure count - IMA group - far end

uasGrp unavailable seconds - IMA group

ivIma ICP violations - IMA group

Table 4-3 (continued)
DS1 carrier threshold types

Type Description
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

sesIma severely errored seconds - IMA link

uasIma unavailable seconds - IMA link

txUusIma transmit unusable seconds - IMA link

rxUusIma receive unusable seconds - IMA link

txFc transmit link failure alarm conditions - IMA link

rxFc receive link failure alarm conditions - IMA link

oifIma OIF anomalies - IMA link

txStuffIma stuffing events in transmit direction - IMA link

rxStuffIma stuffing events is receive direction - IMA link

sesImaFe severely errored seconds - IMA link - far end

—continued—
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reshold types. The UE9000 equipment
n certain parameters exceed the configured

conds - IMA link - far end

able seconds - IMA link - far end

ble seconds - IMA link - far end

ilure alarm conditions - IMA link - far end

ilure alarm conditions - IMA link - far end

—end—

econds

 errored seconds

 error framing seconds

conds

tion

lation

conds

iolation
Table 4-4 lists the DS3 carrier th
generates threshold events whe
threshold value.

uasImaFe unavailable se

txUusImaFe transmit unus

rxUusImaFe receive unusa

txFcFe transmit link fa

rxFcFe receive link fa

Table 4-4
DS3 carrier threshold types

Type Description

pes P-bit errored s

pses P-bit severely

sefs P-bit severely

uas unavailable se

lcv line code viola

pcv P-bit code vio

les line errored se

ccv C-bit coding v

Table 4-3 (continued)
DS1 carrier threshold types

Type Description
UE9000 DMS 297-8391-501 NA015

ces C-bit errored seconds

cses C-bit severely errored seconds

feces far end C-bit errored seconds

fecses far-end C-bit severely errored seconds

—continued—
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feccv far end C-bit coding violation

feuas far end unavailable seconds

—end—

Table 4-4 (continued)
DS3 carrier threshold types

Type Description
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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d (MLC) reports faults to the ATM card. As
there are different faults that are associated
 an entire MLC.

ults, refer to theAccessNode Alarm and
s, 323-3001-543, in Volume 5A:

age 4-30

 on page 4-32 (see Note)

dropped on page 4-33

tion — interleave channel on page 4-35

age 4-37 (see Note)

e 4-39 (see Note)

age 4-41 (see Note)

age 4-43 (see Note)

ck failure on page 4-45

on page 4-46

ode on page 4-50

tion — interleave channel on page 4-52

age 4-54 (see Note)

e 4-56 (see Note)

age 4-58 (see Note)
Line card and circuit faults
Each ADSL multi-circuit line car
shown inTable 4-5andTable 4-6,
with an individual circuit or with

Note: For clearing carrier fa
Trouble Clearing Procedure
Maintenance.

Table 4-5
ADSL line circuit faults

Equipment Fault

ATU-C ATU-C failure on p

ATU-R not present

Downstream cells 

Loss of cell delinea

Loss of frame on p

Loss of link on pag

Loss of power on p

Loss of signal on p

Modem ATU-C clo

Non-zero VPI bits 

ATU-R Incompatible Tx m

Loss of cell delinea

Loss of frame on p

Loss of link on pag

Loss of power on p
UE9000 DMS 297-8391-501 NA015

Loss of signal on page 4-59 (see Note)

Modem Modem training failure on page 4-48

Note: This fault is not displayed in the Alarm Browser. To see this fault,
right-click the CPE symbol on the Subscriber loop submap, and select Show
-> Faults .
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Severity levels
Each fault has one of the following three severity levels:

• Minor  — generally either self-correctable or link-related. Corrective

Table 4-6
ADSL line card faults

Equipment Fault

ATM50 DS FIFO overrun on page 4-61

DS HEC failure on page 4-62

Line signal fault on page 4-63

ATM Lost communication to ATMIF on page 4-65

ATM, line card, circuit,
carrier

Config. failure on page 4-67

ATM, line card Firmware mismatch on page 4-68

Hardware mismatch on page 4-69

Line card In service LC removed on page 4-70
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

actions for these faults include reestablishing a link or waiting for the
fault to clear. Some minor faults are hardware related and require
operator intervention.

• Major  — indicate that a service affecting condition has developed and
an urgent action is required. This severity level can occur, for example,
when there is a severe degradation in the capability of the managed
object. In this case, the object’s full capability must be restored.

• Critical — indicate that a service affecting condition has occurred and an
immediate corrective action is required. This severity level can occur, for
example, when a managed object becomes totally out of service. In this
case, the object’s full capability must be restored.
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s been a critical modem failure. These are the
:

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.

ION
 service
moving the line card from the shelf, you
ait more than five seconds before you
t the line card. If you do not wait more than
conds to reinsert the card, the line card
ATU-C
ATU-C failure

Probable cause
This fault occurs when there ha
types of failures that may occur

• modem not responding

• modem in Kernel mode

• modem download failure

• modem message corrupted

Severity
This is a minor fault.

Action

Step Action

CAUT
Loss of
Remov
both vo
those s

CAUT
Loss of
After re
must w
reinser
five se
UE9000 DMS 297-8391-501 NA015

1 Restart or reseat the line card. For information on restarting the line
card, see Procedure 2-9 on page 2-20.

—continued—

can drop all voice and data service for five to
eight minutes.
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ATU-C
ATU-C failure (continued)

Step Action

2 If the fault remains, replace the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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-C cannot detect the customer premises

is fault is that the CPE has been turned off.

rned on and the phone cord is plugged in.

he subscriber’s loop to the line card.

e the CPE or the line card.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.
ATU-C
ATU-R not present

Probable cause
This fault occurs when the ATU
equipment (CPE).

The most common cause for th

Severity
This is a minor fault.

Action

Step Action

1 Ensure that the CPE is tu

2 Check the connection of t

3 If the fault remains, replac

—end—

CAUT
Loss of
Remov
both vo
those s
UE9000 DMS 297-8391-501 NA015
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ATU-C
Downstream cells dropped

Probable cause
This fault occurs when the downstream modem interface port for the affected
circuit has stopped accepting cells for 2.5 seconds. When this fault is present,
the affected subscriber is not receiving downstream data.

The line card clears this fault after 10 seconds of normal operation.

Severity
This is a minor fault.

Action
Step Action

1 Wait about 5 minutes while the system attempts to re-establish the
link. If it is successful, the fault clears automatically.

CAUTION
Loss of service
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

CAUTION
Loss of service
After removing the line card from the shelf, you
must wait more than five seconds before you
reinsert the line card. If you do not wait more than
five seconds to reinsert the card, the line card
can drop all voice and data service for five to
eight minutes.
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t or reseat the line card. For information on
e Procedure 2-9 on page 2-20.

e the line card.

d by individual circuits on a line card. Other
ay remain operational. You can choose to
ove the subscriber to a functioning circuit.
ATU-C
Downstream cells dropped (continued)

Step Action

2 If the fault remains, restar
restarting the line card, se

3 If the fault remains, replac

Note: This fault is reporte
circuits on the line card m
replace the line card or m

—end—
UE9000 DMS 297-8391-501 NA015



uEMS faults and events  4-35

ATU-C
Loss of cell delineation — interleave channel

Probable cause
This fault occurs when the line card detects 2.5 seconds of LCD-I defects at
the ATU-C. This fault indicates a loss of synchronization of ATM cells in the
upstream interleave channel. When this fault is present, the affected circuit is
not receiving any valid upstream data in the interleave channel.

The line card clears the fault after 10 seconds without an LCD-I defect at the
ATU-C.

Severity
This is a minor fault.

Action

Step Action

1 Wait about 5 minutes while the system attempts to re-establish the
link. If it is successful, the fault clears automatically.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

CAUTION
Loss of service
After removing the line card from the shelf, you
must wait more than five seconds before you
reinsert the line card. If you do not wait more than
five seconds to reinsert the card, the line card
can drop all voice and data service for five to
eight minutes.
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inued)

t or reseat the line card. For information on
e Procedure 2-9 on page 2-20.

e the CPE or the line card.

d by individual circuits on a line card. Other
ay remain operational. You can choose to
ove the subscriber to a functioning circuit.
ATU-C
Loss of cell delineation — interleave channel (cont

Step Action

2 If the fault remains, restar
restarting the line card, se

3 If the fault remains, replac

Note: This fault is reporte
circuits on the line card m
replace the line card or m

—end—
UE9000 DMS 297-8391-501 NA015
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ATU-C
Loss of frame

Probable cause
This fault occurs when the line card detects 2.5 seconds of contiguous
severely errored frame (SEF) defects and there is no loss of signal (LOS)
defect or fault.

The line card clears this fault when an ATU-C LOS fault occurs or when no
SEF defects occur on an active link for 10 seconds.

The most common cause for this fault is that the customer premises
equipment (CPE) has been turned off.

Severity
This is a minor fault.

Action

Step Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

1 Does the subscriber experience intermittent service?

2 Change the circuit provisioning parameters to improve immunity to
severe loop impairment. See the UE9000 Data OAM&P User Guide
for provisioning information. If the fault remains, go to step 3.

—continued—

If Then

yes There may be loop impairment or faulty modems.

Go to step 2.

no Go to step 3.
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he subscriber’s loop to the line card.

e the CPE or the line card.

d by individual circuits on a line card. Other
ay remain operational. You can choose to
ove the subscriber to a functioning circuit.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.
ATU-C
Loss of frame (continued)

Step Action

3 Check the connection of t

4 If the fault remains, replac

Note: This fault is reporte
circuits on the line card m
replace the line card or m

—end—

CAUT
Loss of
Remov
both vo
those s
UE9000 DMS 297-8391-501 NA015
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ATU-C
Loss of link

Probable cause
This fault occurs in the following instances:

• An ATU-C loss of signal (LOS) fault occurred (see“Loss of signal” on
page 4-43) and was not preceded by an ATU-R loss of power fault.

• An ATU-C loss of frame (LOF) fault occurred (see“Loss of frame” on
page 4-37).

• No ATU-C LOS or LOF fault is present and near-end CRC errors in the
last 256 second sample exceeded the threshold, indicating a loss of signal
quality. This condition indicates that the subscriber loop is being
subjected to severe loop impairments in the upstream direction.

The most common cause for this fault is that the customer premises
equipment (CPE) has been turned off.

Severity
This is a minor fault.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Action

Step Action

1 Does the subscriber experience intermittent service?

2 Change the circuit provisioning parameters to improve immunity to
severe loop impairment. See the UE9000 Data OAM&P User Guide
for provisioning information. If the fault remains, go to step 3.

—continued—

If Then

yes There may be loop impairment or faulty modems.

Go to step 2.

no Go to step 3.
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he subscriber’s loop to the line card.

e the CPE or the line card.

d by individual circuits on a line card. Other
ay remain operational. You can choose to
ove the subscriber to a functioning circuit.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.
ATU-C
Loss of link (continued)

Step Action

3 Check the connection of t

4 If the fault remains, replac

Note: This fault is reporte
circuits on the line card m
replace the line card or m

—end—

CAUT
Loss of
Remov
both vo
those s
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ATU-C
Loss of power

Probable cause
This fault occurs when the ATU-C electrical supply power drops to a level
below the pre-determined minimum power level required to ensure proper
operation. The line card clears this fault after 10 seconds of normal power
level on the ATU-C.

Severity
This is a minor fault.

Action

Step Action

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

CAUTION
Loss of service
After removing the line card from the shelf, you
must wait more than five seconds before you
reinsert the line card. If you do not wait more than
five seconds to reinsert the card, the line card will
not restore voice and data traffic for five to eight
minutes.



4-42   uEMS faults and events

card. For information on restarting the line
n page 2-20.

investigate the shelf and line card power
ng normally?

 line card functioning properly?

ER
electric shock
e normal safety precautions when

g near or on the power supply.

ION
 service
ust wait more than five seconds to reapply
If you do not wait more than five seconds,
card will not restore voice and data traffic

 to eight minutes.

.

place the power supply.

r next level of technical support.
ATU-C
Loss of power (continued)

Step Action

1 Restart or reseat the line
card, see Procedure 2-9 o

2 If the problem still exists, 
supplies. Are they operati

3 Are all the modems on the

DANG
Risk of 
Observ
workin

CAUT
Loss of
You m
power.
the line
for five

If Then

yes Go to step 3

no Repair or re

If Then

yes Contact you
UE9000 DMS 297-8391-501 NA015

—end—

no Replace the line card.
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ATU-C
Loss of signal

Probable cause
This fault occurs when the line card detects 2.5 seconds of loss of signal
(LOS) defects. This fault may also occur if a LOS defect is present when the
criteria for a loss of frame fault have been met. A line circuit reports a LOS
defect when the received xDSL pilot tone power has fallen below the
threshold. The threshold is set at 6 dB below the reference power.

The line card clears this fault when no LOS defects occur on an active link for
10 seconds.

The most common cause for this fault is that the customer premises
equipment (CPE) has been turned off.

Severity
This is a minor fault.

Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Step Action

1 Does the subscriber experience intermittent service?

2 Change the circuit provisioning parameters to improve immunity to
severe loop impairment. See the UE9000 Data OAM&P User Guide
for provisioning information. If the fault remains, go to step 3.

—continued—

If Then

yes There may be loop impairment or faulty modems.

Go to step 2.

no Go to step 3.
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he subscriber’s loop to the line card.

the subscriber to another line circuit. Does

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.

m is in the line circuit. Replace the line

m is in the subscriber loop or CPE.
e CPE.
ATU-C
Loss of signal (continued)

Step Action

3 Check the connection of t

4 If the fault remains, move
the fault reoccur?

—end—

CAUT
Loss of
Remov
both vo
those s

If Then

yes The proble
card.

no The proble
Replace th
UE9000 DMS 297-8391-501 NA015
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ATU-C
Modem ATU-C clock failure

Probable cause
This fault occurs when the DMT clock on the line card is not functioning
correctly. When this condition is present, the ATU-C modem cannot link with
the ATU-R.

Severity
This is a minor fault.

Action

Step Action

1 Restart the line card.

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

2 If the fault remains, replace the line card.

—end—

those services on all circuits on the line card.
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ream modem interface port for the affected
tual path identifier (VPI) bits for 2.5 seconds.
ort is dropping all upstream traffic for the

ter 10 seconds of normal operation.

e the system attempts to re-establish the
 fault clears automatically.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.

ION
 service
moving the line card from the shelf, you
ait more than five seconds before you
t the line card. If you do not wait more than
ATU-C
Non-zero VPI bits

Probable cause
This fault occurs when the upst
circuit has received non-zero vir
When this fault is present, the p
affected subscriber.

The line card clears this fault af

Severity
This is a minor fault.

Action

Step Action

1 Wait about 5 minutes whil
link. If it is successful, the

CAUT
Loss of
Remov
both vo
those s

CAUT
Loss of
After re
must w
reinser
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2 If the fault remains, restart or reseat the line card. For information on
restarting the line card, see Procedure 2-9 on page 2-20.

—continued—

five seconds to reinsert the card, the line card will
not restore voice and data traffic for five to eight
minutes.
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ATU-C
Non-zero VPI bits (continued)

Step Action

3 If the fault remains, replace the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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between ATU-C and ATU-R or STU-C and
three consecutive attempts. This fault occurs

s:

mediately after a link is successfully
 and ATU-R or the STU-C and STU-R.

e the system attempts to re-establish the
 fault clears automatically.

e the circuit provisioning parameters to
re loop impairment. See the UE9000 Data
rovisioning information.

ION
 service
ing or reseating a line card that supports
Modem
Modem training failure

Probable cause
This fault occurs when the link 
STU-R fails to establish a link on
in one of the following instance

• data error

• configuration error

• protocol error

• initialization error

The line card clears this fault im
established between the ATU-C

Severity
This is a minor fault.

Action

Step Action

1 Wait about 5 minutes whil
link. If it is successful, the

2 If the fault remains, chang
improve immunity to seve
OAM&P User Guide for p

CAUT
Loss of
Remov
UE9000 DMS 297-8391-501 NA015

—continued—

both voice and data services causes a loss of
those services on all circuits on the line card.
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Modem
Modem training failure (continued)

Step Action

3 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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isioned service for a circuit is incompatible
he CPE. For example, if you plug a G.Lite
 provisioned for T1.413 only, this fault is

esent, the link will never train (i.e. the
use the transmission mode is incompatible. To
E of the following subprocedures.

d with a CPE that supports the provisioned
it, or the provisioned transmission mode for

a mode that is compatible with the CPE.

PE that supports the provisioned
t circuit.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.
ATU-R
Incompatible Tx mode

Probable cause
This fault occurs when the prov
with the transmission mode of t
CPE into a circuit that has been
generated. When the fault is pr
subscriber has no service) beca
correct this situation, performON

Either the CPE must be replace
transmission mode for that circu
the circuit must be changed to 

Severity
This is a minor fault.

Action

Step Action

Replace or move the CPE

1 Replace the CPE with a C
transmission mode for tha

CAUT
Loss of
Remov
both vo
those s
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—continued—
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ATU-R
Incompatible Tx mode (continued)

Changing the provisioned transmission mode

2 Change the ADSL circuit enabling drop down menu option in the
Provision/Edit  dialog box for a circuit.

Note: ADSL circuit enabling of auto detect will allow training in any
mode which should always clear this fault.

Once the transmission mode has been changed to a mode that is
compatible with the CPE, the link should train and the fault should
clear.

—end—

CAUTION
Loss of service
After removing the line card from the shelf, you
must wait more than five seconds before you
reinsert the line card. If you do not wait more than
five seconds to reinsert the card, the line card will
not restore voice and data traffic for five to eight
minutes.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 channel

card detects 2.5 seconds of LCD-I defects at
loss of synchronization of ATM cells in the
When this fault is present, the affected circuit
tream data in the interleave channel.

er 10 seconds without an LCD-I defect at the

e the system attempts to re-establish the
 fault clears automatically.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.

ION
 service
ust wait more than five seconds to
ATU-R
Loss of cell delineation — interleave

Probable cause
This fault occurs when the line 
the ATU-R. This fault indicates a
downstream interleave channel.
is not receiving any valid downs

The line card clears the fault aft
ATU-R.

Severity
This is a minor fault.

Action

Step Action

1 Wait about 5 minutes whil
link. If it is successful, the

CAUT
Loss of
Remov
both vo
those s

CAUT
Loss of
You m
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—continued—

reinsert a line card after removing the line
card from the shelf to reseat it. If you do not
wait more than five seconds, the line card will not
restore voice and data traffic for five to eight
minutes
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ATU-R
Loss of cell delineation — interleave channel (continued)

Step Action

2 If the fault remains, restart or reseat the line card. For information on
restarting the line card, see Procedure 2-9 on page 2-20.

3 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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ard detects 2.5 seconds of contiguous remote
e is no far-end LOS defect or fault. An RDI
e defect that the line card detects at the far

ult when a far-end loss of signal fault occurs
n an active link for 10 seconds.

is fault is that the customer premises
ed off.

rience intermittent service?

oning parameters to improve immunity to
ee the UE9000 Data OAM&P User Guide
n. If the fault remains, go to step 3.

 be loop impairment or faulty modems.

2.

3.
ATU-R
Loss of frame

Probable cause
This fault occurs when the line c
defect indication (RDI) and ther
defect is a severely errored fram
end. The line card clears this fa
or when no RDI defects occur o

The most common cause for th
equipment (CPE) has been turn

Severity
This is a minor fault.

Action

Step Action

1 Does the subscriber expe

2 Change the circuit provisi
severe loop impairment. S
for provisioning informatio

—continued—

If Then

yes There may

Go to step

no Go to step
UE9000 DMS 297-8391-501 NA015
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ATU-R
Loss of frame (continued)

Step Action

3 Check the connection of the subscriber’s loop to the line card.

4 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 instances:

S) fault occurred (see“Loss of signal” on

F) fault occurred (see“Loss of frame” on

lt occurred (see“Loss of power” on

is present and far-end CRC errors in the last
ed the threshold, indicating a loss of signal
ates that the subscriber loop is being
pairments in the downstream direction.

is fault is that the customer premises
ed off.

rience intermittent service?

y be loop impairment or faulty modems.
ATU-R
Loss of link

Probable cause
This fault occurs in the following

• An ATU-R loss of signal (LO
page 4-59)

• An ATU-R loss of frame (LO
page 4-54)

• An ATU-R loss of power fau
page 4-58)

• No ATU-R LOS or LOF fault
256 second sample exceed
quality. This condition indic
subjected to severe loop im

The most common cause for th
equipment (CPE) has been turn

Severity
This is a minor fault.

Action

Step Action

1 Does the subscriber expe

If Then

yes There ma
UE9000 DMS 297-8391-501 NA015

2 Change the circuit provisioning parameters to improve immunity to
severe loop impairment. See the UE9000 Data OAM&P User Guide
for provisioning information. If the fault remains, go to step 3.

—continued—

Go to step 2.

no Go to step 3.
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ATU-R
Loss of link (continued)

Step Action

3 Check the connection of the subscriber’s loop to the line card.

4 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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card detects a far-end loss of power fault
tiguous near-end LOS defects. The line card
nd loss of signal (LOS) defects occur for 10

mer premises equipment may send this fault
normal power off condition.

ises equipment may not send this signal on
ATU-R
Loss of power

Probable cause
This fault occurs when the line 
followed by 2.5 seconds of con
clears this fault when no near-e
seconds.

Severity
This is a minor fault.

Action
No action is required. The custo
when power is removed. It is a 

Note: Some customer prem
power off.

—end—
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ATU-R
Loss of signal

Probable cause
This fault occurs when the line card detects 2.5 seconds of loss of signal
(LOS) defects. This fault may also occur if a far-end LOS defect is present
when the criteria for a loss of frame fault have been met. A line circuit reports
a LOS defect when the received ADSL pilot tone power has fallen below the
threshold. The threshold is set at 6 dB below the reference power.

The line card clears this fault when no LOS defects occur on an active link for
10 seconds.

The most common cause for this fault is that the customer premises
equipment (CPE) has been turned off.

Severity
This is a minor fault.

Action
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Step Action

1 Does the subscriber experience intermittent service?

2 Change the circuit provisioning parameters to improve immunity to
severe loop impairment. See the UE9000 Data OAM&P User Guide
for provisioning information. If the fault remains, go to step 3.

—continued—

If Then

yes There may be loop impairment or faulty modems.

Go to step 2.

no Go to step 3.
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he subscriber’s loop to the line card.

e the CPE or the line card.

d by individual circuits on a line card. Other
ay remain operational. You can choose to
ove the subscriber to a functioning circuit.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.
ATU-R
Loss of signal (continued)

Step Action

3 Check the connection of t

4 If the fault remains, replac

Note: This fault is reporte
circuits on the line card m
replace the line card or m

—end—

CAUT
Loss of
Remov
both vo
those s
UE9000 DMS 297-8391-501 NA015



uEMS faults and events  4-61

ATM50
DS FIFO overrun

Probable cause
The fault occurs when the FIFO buffer in the ATM50 chip set for an xDSL
circuit has repeatedly overrun for 2.5 seconds. When this fault is present, the
line card is dropping some or all downstream cells.

The line card clears this fault after 10 seconds without a FIFO overrun.

Severity
This is a major fault.

Action

Step Action

1 Wait about 5 minutes while the system flushes the FIFO buffer. If the
fault condition stops, the fault clears automatically.

CAUTION
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

2 If the fault remains, restart or reseat the line card. For information on
restarting the line card, see Procedure 2-9 on page 2-20.

3 If the fault remains, replace the line card.

—end—

Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

CAUTION
Loss of service
After removing the line card from the shelf, you
must wait more than five seconds before you
reinsert the line card. If you do not wait more than
five seconds to reinsert the card, the line card
can drop all voice and data service for five to
eight minutes.
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50 chip set for an xDSL circuit detects HEC
nds in the downstream data. When this fault
to the line card from the line card is severely

this fault after 10 seconds without any HEC

he fault condition to clear.

ION
 service
ing or reseating a line card that supports
ice and data services causes a loss of
ervices on all circuits on the line card.

ION
 service
ust wait more than five seconds to reinsert
ard after removing the line card from the
reseat it. If you do not wait more than five
s, the line card can drop all voice and data
 for five to eight minutes.
ATM50
DS HEC failure

Probable cause
The fault occurs when the ATM
errors continuously for 2.5 seco
is present, the downstream data
corrupted. The line card clears 
errors.

Severity
This is a major fault.

Action

Step Action

1 Wait about 5 minutes for t

CAUT
Loss of
Remov
both vo
those s

CAUT
Loss of
You m
a line c
shelf to
second
service
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2 If the fault remains, restart or reseat the line card. For information on
restarting the line card, see Procedure 2-9 on page 2-20.

3 If the fault remains, replace the line card.

4 If the fault remains, check the ATM card and the backplane.

—end—
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ATM50
Line signal fault

Probable cause
This fault occurs when the ATM line between the xDSL line card and the
ATM card does not function properly for 2.5 seconds. When this fault is
present, the line card is not receiving any downstream data and is not sending
any upstream data.

The line card clears this fault after 10 seconds of normal operation.

Severity
This is a critical fault.

Action

Step Action

1 Wait about 5 minutes while the line card attempts to re-establish an
ATM connection with the ATM card. If it is successful, the fault clears
automatically.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—continued—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

CAUTION
Loss of service
You must wait more than five seconds to reinsert
a line card after removing the line card from the
shelf to reseat it. If you do not wait more than five
seconds, the line card can drop all voice and data
service for five to eight minutes.
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t or reseat the line card. For information on
e Procedure 2-9 on page 2-20.

e the line card.

 the ATM card and the backplane.
ATM50
Line signal fault (continued)

Step Action

2 If the fault remains, restar
restarting the line card, se

3 If the fault remains, replac

4 If the fault remains, check

—end—
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ATM
Lost communication to ATMIF

Probable cause
This fault occurs when the uEMS workstation cannot communicate with the
ATMIF card. When this fault occurs, uEMS may not receive reports of alarms.
This alarm could be a transient condition caused by either network congestion
or a reboot of the ATMIF. If the cause is transient, the alarm will automatically
clear within 10 minutes.

Severity
This is a critical fault.

Action
Step Action

1 From the GUI, select the ATMIF icon. then

Fault -> Nortel uEMS verify Comm

This may clear a transient fault.

Note: If the verify Comm tool does not return a pop-up window with
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

the results of the check, wait 10 seconds, and try again.

2 Use a null modem cable to connect the ATM core card’s serial port to
a PC, or connect to the ATM (DS3) card’s 10BaseT Ethernet port and
telnet to the port IP address.

3 Run hyperterm on the PC with this setting:

19200 baud, 1 stop bit, no parity

—continued—
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rd: from the hyperterm window, press the

ould display the "dSH>" prompt.

rom the TL1> prompt, type:

ars.

Then

pt check the router and ATM edge switch
that are in the communication path
between the ATMIF card and the
uEMS workstation. If you cannot find
any problem in this path, call Nortel
Networks Technical Support.

wait two minutes in case the card is
rebooting, then repeat step 4 again.

If there is still no response, reseat the
ATMIF and repeat step 1 through
step 4. If there is no improvement in
the situation, you will need to replace
the ATMIF card.
Procedure 4-3 (continued)
Lost communication to ATMIF

Step Action

4 For DS1 IMA ATM core ca
return key a few times.

The hyperterm window sh

For DS3 ATM core card: f

dsh;

The "dSH>" prompt appe

—end—

If

you get the "dSH>" prom

the "dSH>" prompt does
not display
UE9000 DMS 297-8391-501 NA015
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ATM, line card, circuit, carrier
Config. failure

Probable cause
This fault occurs when uEMS sends configuration messages to the SNMP
agent in the ATMIF firmware to configure the alarmed device, and the SNMP
agent rejects the command. When this alarm occurs, the affected device may
not be able to pass traffic.

Severity
This is a critical fault.

Action

Step Action

1 Call Nortel Networks Technical Support.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01



4-68   uEMS faults and events

isioned loadname is different from the load
condition can be service affecting.

 device and select Provision/Edit

indow appears.

ap Application .

ributes of the device appears.

rrent load and provisioned load. If the
ct, go to step 4. If the current load is

ncorrect, right click the icon of the device
rovisioned Load where XXX = ATMIF or

to change the provisioned load appears.

m the list or type in the name of the load,

ithin a few seconds.

ect, lock the device by right clicking the icon
ATM, line card
Firmware mismatch

Probable cause
This fault occurs when the prov
that is running in the card. The 

Severity
This is a minor fault.

Action

Step Action

1 In uEMS, right click on the

The Object Description w

2 Double click on UE9000 M

A window showing the att

3 Scroll down to find the cu
provisioned load is incorre
incorrect, go to step 6.

4 If the provisioned load is i
and select Change XXX P
Line Card.

A window that allows you 

5 Select the correct load fro
then click OK.

 The alarm should clear w

6 If the current load is incorr
UE9000 DMS 297-8391-501 NA015

of the device and select Maintenance -> XXX -> Lock -> Normal .

7 Reload the firmware on the device by right clicking the icon of the
device and select Maintenance -> XXX -> Reload -> Normal .

8 Unlock the device by right clicking the icon of the device and select
Maintenance -> XXX -> Unlock -> Normal .

—end—
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ATM, line card
Hardware mismatch

Probable cause
This fault occurs when the provisioned hardware type is different from the
hardware that is physically inserted into the slot.

Severity
This is a critical fault.

Action

Step Action

1 Either change the provisioning to match the hardware that is
installed, or replace the hardware to match the type that is
provisioned.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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rd that is in-service is physically removed

ard
Line card
In service LC removed

Probable cause
This fault occurs when a line ca
from the slot.

Severity
This is a minor fault.

Action

Step Action

1 Do one of the following:

• reinsert the line card

• unprovision the line c

• lock the line card

—end—
UE9000 DMS 297-8391-501 NA015
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STU-C
STU-C failure

Probable cause
This fault occurs when the hardware associated with this circuit is bad.

Severity
This is a minor fault.

Action

Step Action

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

CAUTION
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

1 Replace the line card. For information on replacing the line card, see
Procedure 2-9 on page 2-20.

2 If the fault remains, replace the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—

Loss of service
You must wait more than five seconds to reinsert
a line card after removing the line card from the
shelf to reseat it. If you do not wait more than five
seconds, the line card can drop all voice and data
service for five to eight minutes.
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card detects 8 frames of contiguous severely
d there is no loss of signal (LOS) defect or
nfigured during provisioning.

hen you regain frame.

is fault is that the customer premises
ed off.

rience intermittent service?

oning parameters to improve immunity to
ee the UE9000 Data OAM&P User Guide
n. If the fault remains, go to step 3.

 loop impairment or faulty modems.
STU-C
Loss of frame

Probable cause
This fault occurs when the line 
errored frame (SEF) defects an
fault. The frame field can be co

The line card clears this fault w

The most common cause for th
equipment (CPE) has been turn

Severity
This is a minor fault.

Action

Step Action

1 Does the subscriber expe

2 Change the circuit provisi
severe loop impairment. S
for provisioning informatio

—continued—

If Then

yes There may be

Go to step 2.

no Go to step 3.
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STU-C
Loss of frame (continued)

Step Action

3 Check the connection of the subscriber’s loop to the line card.

4 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 instances:

S) fault occurred (see“Loss of signal” on

F) fault occurred (see“Loss of frame” on

is fault is that the customer premises
ed off.

rience intermittent service?

oning parameters to improve immunity to
ee the UE9000 Data OAM&P User Guide
n. If the fault remains, go to step 3.

e loop impairment or faulty modems.
STU-C
Loss of link

Probable cause
This fault occurs in the following

• An STU-C loss of signal (LO
page 4-43).

• An STU-C loss of frame (LO
page 4-37).

The most common cause for th
equipment (CPE) has been turn

Severity
This is a minor fault.

Action

Step Action

1 Does the subscriber expe

2 Change the circuit provisi
severe loop impairment. S
for provisioning informatio

—continued—

If Then

yes There may b

Go to step 2.

no Go to step 3.
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STU-C
Loss of link (continued)

Step Action

3 Check the connection of the subscriber’s loop to the line card.

4 If the fault remains, replace the CPE or the line card.

Note: This fault is reported by individual circuits on a line card. Other
circuits on the line card may remain operational. You can choose to
replace the line card or move the subscriber to a functioning circuit.

—end—

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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card loses sync with the remote CPE.

hen no LOS defects occur on an active link.

is fault is that the customer premises
ed off.

rience intermittent service?

oning parameters to improve immunity to
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n. If the fault remains, go to step 3.

be loop impairment or faulty modems.

2.

3.
STU-C
Loss of signal

Probable cause
This fault occurs when the line 

The line card clears this fault w

The most common cause for th
equipment (CPE) has been turn

Severity
This is a minor fault.

Action

Step Action

1 Does the subscriber expe

2 Change the circuit provisi
severe loop impairment. S
for provisioning informatio

—continued—

If Then

yes There may 

Go to step

no Go to step
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STU-C
Loss of signal (continued)

Step Action

3 Check the connection of the subscriber’s loop to the line card.

4 If the fault remains, move the subscriber to another line circuit. Does
the fault reoccur?

CAUTION
Loss of service
Removing or reseating a line card that supports
both voice and data services causes a loss of
those services on all circuits on the line card.

If Then

yes The problem is in the line circuit. Replace the line
card.

no The problem is in the subscriber loop or CPE.
Replace the CPE.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—end—
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card detects a far-end loss of power fault.

mer premises equipment may send this fault
normal power off condition.

ises equipment may not send this signal on
STU-R
Loss of power

Probable cause
This fault occurs when the line 

Severity
This is a minor fault.

Action
No action is required. The custo
when power is removed. It is a 

Note: Some customer prem
power off.

—end—
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STU-R
Remote alarm indicator

Probable cause
This fault occurs when the CPE sends a remote alarm indication to the line
card.

Note: Some customer premises equipment may not send this signal on
power off.

Severity
This is a minor fault.

Action

Step Action

1 Replace the CPE or check the line between the line card and the
CPE.

2 If the fault remains, replace line card.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

—end—
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 circuit cannot handle the speed of traffic

n the Service Descriptor field with the circuit
nd adjust them accordingly. Adjust the Service
e data rate up as needed.
Hardware Failure
Downstream cell buffer overflow

Probable cause
This fault occurs when an xDSL
coming in from the ATM card.

Severity
This is a major fault.

Action
Step Action

1 Compare the cell rates i
provisioned data rate a
Descriptor down and or th

—end—
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Hardware Failure
Upstream cell buffer overflow

Probable cause
This fault occurs when there is severe congestion in the network or in the
ATM core card. The fault may clear itself. If it persists, the fault may indicate
a provisioning issue.

Severity
This is a major fault.

Action
Step Action

1 Compare the cell rates in the Service Descriptor field with the circuit
provisioned data rate and adjust them accordingly. Adjust the Service
Descriptor down and or the data rate up as needed.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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 failure occurs.

cedure 2-12, “Replacing an xDSL
-32.
Hardware Failure
ATM device timeout

Probable cause
This happens when a hardware

Severity
This is a major fault.

Action
Replace the line card. Refer toPro
multi-circuit line card” on page 2

—end—
UE9000 DMS 297-8391-501 NA015
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Hardware Failure
ATM device parity error

Probable cause
This fault occurs when you get a parity error. This fault should clear on its
own. If the fault stays raised, then a hardware problem exists.

Severity
This is a major fault.

Action
If the fault does not clear, replace the line card. Refer toProcedure 2-12,
“Replacing an xDSL multi-circuit line card” on page 2-32.

—end—
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01
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List of terms 5-

This chapter defines many of the acronyms and terms used in this user guide.

10Base-T
An Ethernet standard that allows Ethernet encoded data to be transported over
unshielded twisted pair telephone wire. 10Base-T provides an operating rate
of 10 megabits per second.

ADSL
asymmetric digital subscriber line. It is modem technology that enables the
UE9000 CPE to send both data and voice over existing twisted pair copper
wires to and from the end user. The data and voice signals are sent using
different spectrums, which allow both signals to be sent over the same wire
simultaneously. ADSL technology is asymmetric, which means the upstream

ARP

ATM
MS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

and downstream data rates can be different.

address resolution protocol, part of ICMP (SeeRFC792, Internet Control
Message Protocol), which itself is an integral part of IP. In IP, ARP is used to
discover the hardware MAC address of a destination device when only its IP
address is known. See RFC826, An Ethernet Address Resolution Protocol.

Asynchronous transfer mode. A protocol that packs digital information into
53-byte cells (5 byte header and 48 bytes of payload) that are switched
throughout a network over virtual circuits. Standardized by the ITU-T in 1988
to create a Broadband Integrated Services Digital Network (B-ISDN). Its
ability to accommodate multiple types of media (voice, video, data) make it a
very useful for full service networks based on ADSL and VDSL.
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ffice end. Traffic from the ATU-R to the
ream. Traffic from the ATU-C to the ATU-R
.

nd. Traffic from the ATU-R to the ATU-C is
ffic from the ATU-C to the ATU-R is

st unit of information that a computer can

th which is used to represent a value, such as
bol, and so on. A byte is usually 8 bits long.

remise equipment, which is the modem in the
UE9000 CPE routes voice traffic from a
affic from one computer to the ANX and

is currently the only type of DAC that uEMS
ATU-C
ADSL transceiver unit, central o
ATU-C is considered to be upst
is considered to be downstream

ATU-R
ADSL transceiver unit, remote e
considered to be upstream. Tra
considered to be downstream.

bit
binary digit, which is the smalle
process. A bit is either a 0 or 1.

byte
a group of bits of a defined leng
a letter, punctuation mark, sym

CO
central office

CPE
Universal Edge 9000 customer p
end-user’s home or office. The 
standard telephone and data tr
vice-versa.

DAC
data access card. The ATM card
supports.

DLC
digital loop carrier

DMS
UE9000 DMS 297-8391-501 NA015

digital multiplex switch

event
a system occurrence that requires user notification. uEMS events are
generated using SNMP. The following are some conditions that generate
uEMS events:

• a threshold limit was exceeded
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• the configuration of a node changed

• the status of a node changed

• a warm or cold restart occurred on a node

gateway
a device that connects two separate networks together. A gateway allows
devices on one network to access a second network.

GUI
graphical user interface

HEC
header error check

HPOV NNM
Hewlett Packard OpenView Network Node Manager. This is an Internet
protocol (IP) network manager application. It is also used to provide a
common manager platform for multiple applications such as uEMS.

HSTP
high speed twisted pair

IMA
Inverse Multiplexing for ATM. See ATM Forum documentaf-phy-0086.001,
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

Inverse Multiplexing for ATM (IMA) Specification Version 1.

IP
Internet Protocol. SeeRFC-791, Internet Protocol.

LAN
local area network

MAC address
media access control address, a unique 48-bit number assigned to
every physical Ethernet interface device (such as a network interface
card). The first 24 bits are the OUI (organizationally unique identifier)
assigned by the IEEE for manufacturer identification, and the
remaining 24 bits are assigned by the manufacturer for the serial
number. See RFC1700, Assigned Numbers or
http://standards.ieee.org/regauth/oui/index.shtml, for more details on
assigned OUIs.
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A MIB is a collection of standard information
device on the UE9000 network has a MIB that

ntenance, & provisioning

atabase which is used to represent the
the UE9000 network. An object can be a
are device, or a logical entity, such as a group

e byte (8 bits long)

module for the common-equipment shelf or
he OPC provides OAM&P to the access

lves, host digital terminals (HDT), and other
 control.
MDF
main distribution frame

MIB
management information base.
about a device. Each managed
is accessed using SNMP.

MLC
multi-circuit line card

NIC
network interface card

OAM&P
operations, administration, mai

object
is an entry in the HPOV NNM d
attributes of a specific entity in 
physical entity, such as a hardw
of hardware devices.

octet
a frame of information that is on

OPC
operations controller. A plug-in 
an operations controller shelf. T
bandwidth manager (ABM) she
network elements in its span of

POTS
plain old telephone service
UE9000 DMS 297-8391-501 NA015

PPP
point-to-point protocol

protocol
a set of rules that enables two machines having similar functions to
communicate with each other
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PSTN
public switched telephone network

selection name
HP OpenView and uEMS software identify objects by their selection name
and unique name. No two objects in the same network can have the same
selection name. The selection name must be unique for each object in the
uEMS database. The selection name can be sixteen characters long. Do not
use spaces. It can consist of alphanumeric and symbol characters.

SNMP
a protocol used to manage TCP/IP-based networks. See RFC1157, Simple
Network Management Protocol.

submap
a view of a specific section of the UE9000 network

subnet mask
allows the subdividing of a contiguous range of IP addresses into smaller,
more manageable subnetworks. SeeRFC0950, Internet Standard Subnetting
Procedure andRFC1519, Classless Inter-Domain Routing (CIDR): an
Address Assignment and Aggregation Strategyfor more information.
UE9000 DMS Data Testing and Troubleshooting Guide 297-8391-501 Standard 01.01

TCP
transmission control protocol, which is a protocol in the TCP/IP suite of
protocols. It provides reliable end-to-end data transmission.

TFTP
trivial file transfer protocol

uEMS
Universal Edge 9000 Element Management System, which is a graphical user
interface that provides OAM&P for UE9000 data service. uEMS runs on a
Hewlett-Packard UNIX workstation or a Sun Microsystems Solaris
workstation running HPOV NNM. uEMS communicates with the data
processor using SNMP.

VF
voice frequency

VLAN
virtual local area network
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ic name for digital subscriber line equipment
 line technologies provide high-speed digital
used for analog connection. Some DSL
SL, Nortel Networks proprietary 1-Meg
.ee also ADSL.

 this document that refer to xDSL line cards
rcuit line cards.
xDSL
x digital subscriber line. A gener
and services. Digital subscriber
bit stream over the same wires 
technologies are asymmetric D
Modem, and synchronous DSLS

Procedures and descriptions in
apply to the ADSL 4+4  multi-ci
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LED Quick Reference
Circuit pack LEDs indicate card status.

For normal operation, all LEDs are off , or only the green LED is on . Any of the LEDs can be on
simultaneously. On power up, the LEDs are on  briefly before normal operation resumes.

Note: If there are two DS3 ATM core cards in the UE9000 shelf, the system LEDs on the
standby DS3 core card are off  when the card is ready and active-capable.

LEDs for core cards and multi-circuit line cards

Meaning:  Maintenance activity in progress
Causes: Loopback in place, download occurring, booting, line under test, etc.
Action:  This is a temporary condition. Do not replace the card

Meaning:  Critical hardware failure
Causes: Full or partial card failure, non-downloadable firmware incorrect, loss
of signal on any interface, loss of framing, incorrect provisioning
Action:  Check provisioning. If not correct, replace the card

Meaning:  Activity in active/standby units
Causes:  Customer voice or data traffic exists
Action:  Removing the card will interrupt service

LED (single, tri-color) on DS3 core card  for DS3 network connection

Meaning:  Network loss of signal (LOS) or loss of frame (LOF) detected

Meaning:  Remote alarm indication (RAI) signal detected

Meaning:  Normal activity

LEDs for the shelf interconnect (SI) card

Meaning:  Shelf fail (any card failed)

Meaning:  Fail (SI)

Meaning:  Active

Amber

Red

Green

Red

Amber

Green

Red

Red

Green
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